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VISION 

 

 To Excel in the emerging areas of Computer Science and Engineering by 

imparting quality education , relevant practices and inculcating human values 

to transform the students as potential resources to contribute innovatively to 

meet industrial needs and social expectations. 

 

 

MISSION 

M1: To provide strong fundamentals and value - based technical education 

for Computer Science applications through effective teaching learning 

methodologies. 

M2:   To transform lives of the students by nurturing ethical values, creativity 

and novelty to become Entrepreneurs and establish start-ups. 

M3: To Impart high quality experiential learning to get expertise in modern 

software tools and to cater to the real time requirements of the industry 

M4: To provide a conducive environment for faculty to engage in and train 

students in progressive and convergent research themes through 

collaborative linkages with industry and academia by establishing 

Centres of Excellence. 

M5: To inculcate problem solving and team building skills and promote 

lifelong learning with a sense of societal and ethical responsibilities. 

 

 



 
 

 
PROGRAM OUTCOMES (POS) 

Engineering Graduates will be able to: 

PO1.ENGINEERING KNOWLEDGE: Apply the knowledge of mathematics, science, 

engineeringfundamentals, and an   engineering specialization to the solution of complex 

engineering problems. 

PO2.PROBLEM ANALYSIS: Identify, formulate, review research literature, and analyze 

complexengineering problems reaching substantiated conclusions using first principles of 

mathematics,natural sciences, and engineering sciences. 

PO3.DESIGN/DEVELOPMENT OF SOLUTIONS: Design solutions for complex 

engineering problems anddesign system components or processes that meet the specified 

needs with appropriateconsideration for the public health and safety, and the cultural, 

societal, and environmentalconsiderations. 

PO4.CONDUCT INVESTIGATIONS OF COMPLEX PROBLEMS: Use research-based 

knowledge and researchmethods including design of experiments, analysis and 

interpretation of data, and synthesis of theinformation to provide valid conclusions. 

PO5.MODERN TOOL USAGE: Create, select, and apply appropriate techniques, resources, 

and modernengineering and IT tools including prediction and modelling to complex 

engineering activitieswith an understanding of the limitations. 

PO6. THE ENGINEER AND SOCIETY: Apply reasoning informed by the contextual 

knowledge to assesssocietal, health, safety, legal and cultural issues and the consequent 

responsibilities relevant tothe professional engineering practice. 

PO7.ENVIRONMENT AND SUSTAINABILITY: Understand the impact of the professional 

engineeringsolutions in societal and environmental contexts, and demonstrate the 

knowledge of, and needfor sustainable development. 



 
 

PO8.ETHICS: Apply ethical principles and commit to professional ethics and responsibilities 

andnorms of the engineering practice. 

PO9.INDIVIDUAL AND TEAM WORK: Function effectively as an individual, and as a 

member or leaderin diverse teams, and in multidisciplinary settings. 

PO10.COMMUNICATION: Communicate effectively on complex engineering activities with 

theengineering community and with society at large, such as, being able to comprehend 

and writeeffective reports and design documentation, make effective presentations, and 

give and receiveclear instructions. 

PO11.PROJECT MANAGEMENT AND FINANCE: Demonstrate knowledge and 

understanding of theengineering and management principles and apply these to one’s 

own work, as a member andleader in a team, to manage projects and in multidisciplinary 

environments. 

PO12.LIFE-LONG LEARNING: Recognize the need for, and have the preparation and ability 

to engage inindependent and life-long learning in the broadest context of technological 

change. 

 

 
 
 
 
 
 
 
 
 
 
 



 
 

Program Specific Outcomes (PSOs) 
The Computer Science & Engineering graduate will 

PSO-1 Professional Skills: 

The Computer Engineering Graduates are able to understand, 

analyze and develop computer programs in the areas related to 

algorithms, system software, multimedia, web design, big data 

analytics and networking for efficient design of computer based 

systems of varying complexity. 

PSO-2 

Successful Career 

and 

Entrepreneurship:  

The Computer Engineering Graduates are able to employ 

modern computer languages, environments, and platforms in 

creating innovative career paths to be an entrepreneur and 

enthusiastic for higher studies/employability in the field of 

Computer Science & Engineering. 
 

Program Educational Objectives (PEOs) 
The Programme Educational Objectives of the B.Tech in Computer Science & Engineering 
programme are given below and are numbered from PEO1 to PEO4. 

PEO-1 

To provide the graduates with solid foundation in computer science and 

engineering along with fundamentals of Mathematics and Sciences in formulating, 

analyzing, designing, modelling, programming and implementation  with global 

competence and helps the graduates for life-long learning. 

PEO-2 

To Promote collaborative learning and team work spirit through multi -

disciplinary projects and diverse professional activities and prepare  graduates 

with recent technological developments related to core subjects like programming, 

databases, design of compilers and Network Security aspects and future 

technologies so as to contribute effectively for Research & Development by 

participating in professional activities like publishing and seeking copy rights. 

PEO-3 

To train graduates to choose a decent career option either in high degree of 

employability /Entrepreneur or, in higher education by empowering students with 

sustainable progress, ability to handle critical situations and training to excel in 

competitive examinations. 



 
 

PEO-4 
To exhibit professionalism, ethical attitude, communication, managerial skills, 

teamwork, and social responsibility in their profession and adapt to current 

trends by engaging in continuous learning.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

GENERAL INSTRUCTIONS 

 

Do’s  

1. Please leave footwear outside the laboratory at the designated place.   

2. Please keep your belongings such as bags in the designated place.  

3. Students must present a valid ID card before entering the computer lab. 

4. Maintain Discipline in the laboratory.  

5. Work on the designated computers only.  

6. Do keep your computer and workspace clean and organized. 

7. Do save your work frequently to avoid data loss. 

8. Do follow ethical guidelines and respect copyright when using digital resources. 

9. Students must inform the in-charge Lecturer of any observed hardware or software 

failures. 

10. Turn off the respective systems and arrange the chairs before you leaving the laboratory. 

 

Don’ts  

1. Don’t touch the computer with a pen or pencil.  

2. Don’t eat or drink near your computer.  

3. Don’t touch wires or cables when the computer is on.  

4. Do not install, uninstall or alter any software on the computer. 

5. Students are not allowed to use personal Pen Drives, CDs, DVDs etc., in a Computer 

Lab. Only prescribed official Pen Drives, CDs, DVDs etc. will be used in the Computer 

Lab to avoid VIRUS in Computers. 

6. The use of cell phones is prohibited in the computer lab. 

7. Don’t forget to turn off your computer before leaving. 

 

 



 
 

IT WORKSHOP OBJECTIVES AND OUTCOMES 

(Common to all branches of Engineering) 

Course Objectives: 

• To introduce the internal parts of a computer, peripherals, I/O ports, connecting cables  

• To demonstrate configuring the system as Dual boot both Windows and other Operating 

Systems Viz. Linux, BOSS  

• To teach basic command line interface commands on Linux.  

• To teach the usage of Internet for productivity and self-paced life-long learning  

• To introduce Compression, Multimedia and Antivirus tools and Office Tools such as Word 

processors, Spread sheets and Presentation tools.  

 

Course Outcomes:  

CO1: Perform Hardware troubleshooting.  

CO2: Understand Hardware components and inter dependencies.  

CO3: Safeguard computer systems from viruses/worms.  

CO4: Document/ Presentation preparation. 

CO5: Perform calculations using spreadsheets. 
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PC Hardware & Software Installation 

 

Task 1 

Identify the peripherals of a computer, components in a CPU and its functions. Draw the block 

diagram of the CPU along with the configuration of each peripheral and submit to your 

instructor.  

 

AIM: To Identify the peripherals of a computer, components in a CPU and its functions and to draw 

the block diagram of the CPU along with the configuration of each peripheral.To assemble an 

disassemble the PC back to working condition..  

Hardware Requirements: Cabinet, Hard Disk, CD/DVD Drive, Floppy Drive, Monitor, Mouse, 

Keyboard, Mother Board, Socket 478, Processor, Heat Sink Fan, RAM Slots, PCI Slot, AGP Slots, 

CMOS Battery, BIOS, North Bridge, South Bridge, IDE Slots, SMPS, ATX power Connector.  

Software Requirements: Not Required  

 

INTRODUCTION TO COMPUTER:  

A computer is a programmable machine or computer is an electronic device which takes the input 

information from the input device, process or executes the input in Processor or CPU and generates 

the output information through output devices. Computer enables arithmetic computations, data 

processing, information management (storage) and knowledge reasoning in an efficient manner.  

 

BLOCK DIAGRAM OF COMPUTER 

 
 

Basically the computer system has three major components. These are  

1. Central Processing Unit (Processor)  

2. Input and Output Unit.  

3. Memory Unit (Main Memory and Auxiliary storage).  

 

1. CENTRAL PROCESSING UNIT:  

The Central Processing Unit takes the input data from the input devices and processes it according to 

the set of instructions. After that generate the output and sends the output to the output devices. The 

CPU is composed three parts. These are  

a) ALU: Arithmetic Logical Unit (ALU) is used to do the arithmetic operations on data by adding, 

subtracting, dividing, multiplying and incrementing and decrementing.  
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It is also used for Logical operations like AND, OR, NOT and X-OR.  

b) CU: Control unit is mainly used for generating the electronic control & timing signals for 

program execution. It controls all the operations of the computer.  

c) Registers: CPU also possesses the memory to hold the data temporarily during the execution of an 

instruction. These are small memory locations in CPU.  

 

2. INPUT AND OUTPUT UNIT:  

INPUT DEVICE: Input devices accept the data and instructions from the user.  

Ex: Mouse, Scanner, Keyboard, joysticks, digital cameras, microphones, etc…  

OUTPUT DEVICE: Output devices return the processed data back to the user.  

Ex: Monitor, Printer, etc…  

 

3. MEMORY UNIT:  

Memory is like an electronic scratch pad inside the computer. It is a storage unit to hold the data. In 

the computer the data will be stored and retrieved in the form of bits and bytes. The byte will store a 

single character such as a letter of the alphabet or a numeral.  

a) 8 BITS = 1 BYTE 

b) 1024 BYTES = 1 KB  

c) 1024 KB = 1 MB  

d) 1024 MB = 1 GB  

e) 1024 GB = 1 TB.  

 

The memory can be classified into two categories. These are  

I. primary or main memory  

II. Secondary or auxiliary memory  

 

I. PRIMARY OR MAIN MEMORY:  

Primary memory is the fastest memory in a computer. This memory is primarily (temporarily) used 

to store the data and programs during the execution of a program.  

Primary memory is classified into two categories called  

a) Random Access Memory (RAM)  

b) Read Only Memory (ROM)\  

 

II. SECONDARY OR AUXILIARY MEMORY:   

Secondary memory used to store the data permanently. The data will be stored in storage devices. 

Storage devices are like Magnetic disks, Hard disks, Floppy disks, Compact disks  

 

IDENTIFICATION OF PERIPHERALS:  

1. Cabinet:  

It is used to install all hardware devices like (Mother  Board,  
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SMPS, HDD, CD ROM, and FDD). It has Start,Restart Button, Led’s, Audio and USB 

Connecters  are available at front side. 

 

2. The Mother Board/ System Board  

In Personal Computers, a Mother Board is the central printed  

circuit Board (PCB) in many modern computers and holds  

many of the crucial components of the system, providing connectors for other peripherals. It is also 

called as main board or system board.  

Classification of Mother Boards:  

1) Integrated Mother Boards have all the peripheral device slots, input output ports, serial and 

parallel ports are mounted on the board.  

2) Non-Integrated Mother Boards have all peripheral device slots and input output ports,, serial 

and parallel ports are connected using expansion Boards.  

 

List of Mother Board Manufactures are: Intel, Zebronics, Acer Inc.,VIA Technologies, etc. 

 

Mother Board  

Mother Board Parts:  

a) Socket 478: It has 478 pin slots to place the CPU in it and above the CPU place the Heat Sink Fan 

to cool the processor when it generates the heat and we can fix the fan with locks.  

 
Mother Board  

Mother Board Parts:  

a) Socket 478: It has 478 pin slots to place the CPU in it and above the CPU place the Heat Sink Fan 

to cool the processor when it generates the heat and we can fix the fan with locks.  
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b) CPU or Processor  

CPU The central processing unit contains the heart of any computer, the processor. The processor is 

fitted on to a Mother Board. The Mother Board contains various components, which support the 

functioning of a PC. Clock Speed measures how fast a processor completes operations, usually 

measured in megahertz and gigahertz. A 1.8GHz processor runs at 1,800,000,000 cycles per second. 

List of CPU Manufacturers are: AMD, INTEL, Samsung, IBM, Transmeta, etc 

       
 

c) RAM Slots and RAMs  

RAM Slots are used to place the RAM Cards. RAMs are used to increase the processing speed the 

system to run application more effectively, and it has temporary memory. We have two types of 

RAMs  

i) SD RAM (Synchronous Dynamic), it has two Gaps/Notche  

ii) DDR RAM (Double Data Rate), it has one Gap/Notch  

   
DDR RAM       SD RAM 
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Manufactures of RAM’s are Transcend, Kingston, Micron, Hynix, etc.  

d) North Bridge: It is also called as controller. It converts electronic signals to 

 binary values and binary values to electronic signals. 

 

 

 

 

e) South Bridge:  

It is controls major components of mother board and it is a back bone of the  

input out devices. It is communicates PCI slots, IDE-1, IDE-2,floppy connecter, 

 BIOS chip. 

 

 

f) CMOS (Complementary Metal Oxide Semiconductor) Battery  

Computer is using a coin shape battery. It generates the clock signal and 

 it manages system time continuously. 

 

g) Primary & Secondary(IDE-1 & IDE-2) :  

Mainly there are three IDE slots and cables i.e. IDE-1 (Primary) to connect Hard Disk Drive having 

40 pin slot and 80 wire cable, IDE-2 (Secondary) to connect CD/DVD Drive having 40 pin slot and 

40 wire cable, IDE-3 (Tertiary) to connect Floppy Drive having 35 pin slot 3.5inch wire with a cut in 

middle. But present mother boards does not have IDE-3 slot. 

     
 

h) Input & Output ports :  

I/O ports are used to connecting I/O device such as key boards, mouse, monitor, printer, scanner, 

speakers etc...  
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i) AGP Slot & AGP Card :  

Accelerated Graphic Port (AGP) Slot is used install the AGP card. AGP back view same as VGA 

port (15-pins) and used to connecting the monitors. 

     
j) PCI(Expansion) Cards, PCI Slots :  

PCI (Peripheral Component Interconnect) slots are used to place the PCI cards such as LAN 

(Ethernet) Card, Sound Card, TV Tuner Card, etc. 

 

  
LAN Card     Sound Card     TV Tuner Card 

k) BIOS Chip :  

BIOS (Basic Input Output System) controls how the operating 

 system and hardware wok together and manages all the hardware  

devices installed in mother board. 

 

l) ATX Power connecter Slot:  

ATX (Advanced Technology Extended) power  

connector slot used to place the ATX power  

connector from SMPS to supply the power to motherboard. 

 

 

3. SMPS (Switched mode Power Supply)  

To supply the power to all the components inside the cabinet  

and it is a case that holds a transformer, voltage control and fan. 

 

 

 

4. HDD (Hard Disk Drive)  
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HDD is a device for storing and retrieving digital information, primarily computer data. It consists of 

rotating discs (often referred to as platters), coated with magnetic material and with magnetic heads 

arranged to write data to the surfaces and read it from them. 

List of Manufacturers of HDD Devices are: Hitachi, Samsung, Toshiba, Seagate Technology 

    
5. CD-ROM Drive/ DVD ROM Drive  

CD Drive the most common type of removable media.  

The common types are: CD-ROM, CD-RW, CD-R, DVD,  

DVD-ROM., DVD-RW, DVD-R 

 

 

 

6. Different Screws Used:  

A Computer system has three kinds’ screws  

i) Mother Board Screws (Small Size)  

ii) HDD, CD/DVD, FDD Drive Screws (Medium Size)  

iii) Outer screws to fix sides of cabinet (Large Size)  
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Task 2 

Every student should disassemble and assemble the PC back to working condition. Lab 

instructors should verify the work and follow it up with a Viva. Also students need to go 

through the video which shows the process of assembling a PC. A video would be given as part 

of the course content. 

 

AIM: To disassemble and assemble the PC back to working condition 

Hardware Requirements: Cabinet, Hard Disk, CD/DVD Drive, Floppy Drive, Monitor, Mouse, 

Keyboard, Mother Board, Processor, Heat Sink Fan, RAM Cards, PCI Cards, AGP Card, CMOS 

Battery, IDE cables, SMPS, ATX power Connector.  

Software Requirements: Not Required  

Safety Precautions:  

1. Beware of electrostatic discharge (ESO)  

2. Build computer on a hard surface, away from concepts.  

3. Wear shoes and the short sleeved cotton wear.  

4. Use Phillips, head screw driver.  

5. Keep the components away from moisture.  

6. Avoid using pressure while installing.  

 

Steps for Assembling:  

1. Setting the cabinet ready.  

2. Preparing to fit the components.  

3. Fitting the mother board.  

4. Fitting the RAM, processor and cooler.  

5. Installing PCI cards.  

6. Fitting the hard disk and floppy drive.  

7. Installing the CD ROM drives.  

8. Connecting the ribbon cables.  

9. Powering the drives and mother board.  

10. Connecting the cables for the case front panel.  

11. Final check.  

 

Getting the Cabinet ready:-  

1. Check how to open the cabinet and determine where to fix the components.  

2. Determine if the case has the appropriate risers installed.  

Preparing to fit the Components: 

1. Network adapter drive.  

2. Floppy disk drive.  

3. BUS cables.  

4. Hard disk.  
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5. CD-ROM Drive.  

6. RAM  

7. CPU  

8. Heat sink / cooler / fan.  

9. Mother board.  

10. Screws.  

 
Fitting the Mother board:  

1. Line up the patch on the motherboard with the appropriate holes in the block panel I/O shield of 

the case.  

2. Check the points where you and to install  

3. Install them and make the mother board sit on them and fix screws if required  

 
Fitting the processor:  

1. Raise the small lever at the side of the socket.  

2. Notice that there is a pin missing at one corner, determine the direction to fit in the processor.  

3. You should not force the CPU. When inserting it. All pins should slide smoothly into the socket.  

4. Lock the lever back down.  

5. Install the heat sink over it (Different type for each processor). Heat sink / CPU fan.  

      
 

Fitting the RAM:  

1. The RAM must be suitable for motherboard.  

2. There are currently 2 types of RAM available.  

a) SD RAM.  

b) DDR RAM.  

3. The mother board’s chipset determines which type of RAM may be used.  
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Installing the PCI Cards:  

1. Most of the cards are inbuilt these days.  

2. Network Interface Cards, Sound Cards etc. are fitted into PCI slots.  

Fitting the hard disk and Floppy disk:  

1. Place the floppy and hard disks in their slots.  

2. Leave some space above HDD to prevent heat building.  

3. Check the jumper configuration.  

4. Fix the screws.  

 

Installing the CD-ROM Drives:  

1. CD-ROM drive is similar to installing a hard disk.  

2. 1ST check that the jumper configuration is correct.  

3. Fix the screw.  

      
 

Connecting the BUS Cables, power connectors:-  

1. Attach the long end of the cable to the IDEU connector on the motherboard first.  

2. The red stripe on the IDE cable should be facing the CD Power.  

      
Final Check:-  

1. Mother board jumper configurations are the settings for the processor operator.  

2. Drive jumper settings, master/ slave correct?  

3. Is the processor, RAM modules and plug in cards finally seated in their sockets?  

4. Did you plug all the cables in? Do they all fit really?  
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5. Have you frightened all the screws in plug- in cards or fitted the clips?  

6. Are the drive secure?  

7. Have u connected the power cables to all driver?  

 



Task 3
Every  student  should  individually  install  MS  windows  on  the  personal  computer.  Lab 
instructor should verify the installation and follow it up with a Viva. 

AIM: Performing a Clean Installation of Windows 10 
Software Requirement: Windows 10 software 
Hardware Requirement: Personal computer
Theory: 
To perform a clean installation of Windows 10, insert a bootable media DVD or USB pen drive in 
your computer system, and press any key to boot from the bootable disk. Let the disk allow the 
loading of the setup file. Follow the steps below for clean installation of Windows 10

Follow the steps below to proceed with the Windows 10 installation. 
1. Select the following Language, Time, and Keyboard Layout and select “Next”.

2. Select “Install now” option.

3. Enter the product key to activate Windows and press “Next”, or press “Skip” to enter a valid 
product key later.

12



4. Check the box next to “I accept the license terms” and select “Next”

5. Choose the type of installation to perform. - To upgrade to Windows 10 from an earlier version  
of Windows, select the “Upgrade” option below. - To perform a clean OS installation, select  
“Custom: Install Windows only (advanced)” option below. For instructional purposes, this option 
was selected below.

6. Select the “Load driver” option to load the appropriate driver for the storage device.

13



7. Make sure to load the appropriate storage device driver onto a CD, DVD, or USB flash drive 
before completing the next step. The storage device drivers can be found on the Lenovo Support 
website here. - For storages devices attached to the Intel storage controller, load the Intel Rapid  
Storage Technology enterprise (RSTe) driver. o Select “Browse”, and browse to the CD, DVD, 
or USB flash drive to where the storage device driver is located and select “OK”.

For storages devices attached to the Broadcom controller, load the Broadcom storage driver. o Select 
“Browse”, browse to the CD, DVD, or USB flash drive to where the storage device driver is located 
and select “OK”.

14



8. Select the driver to install.

9. Select the drive to install Windows and select “Next” at the bottom.

10.Installing Windows screen.
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11.After  the installation completes,  the system will  automatically reboot.  If  no product  key was 
entered above, then it’ll prompt to enter a product key again. Either enter the product key here and  
select “Next” or select “Do this later” at the bottom left. 

12.Select “Use Express Settings” at the bottom right to use the default settings or select “Customize 
settings” at the bottom left. For instructional purposes, “Use Express settings” was selected. 

13.Create an account by typing a “User name”. Optionally, type a password to make it secure. 

14.Windows 10 desktop screen. 
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15.At this point, download and install the appropriate device drivers, i.e. Intel Chipset, Intel AMT, 
Ethernet, Graphics, etc.
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Task 4
Every student  should install  Linux on the computer.  This  computer should have windows 
installed. The system should be configured as dual boot (VMWare) with both Windows and 
Linux. Lab instructors should verify the installation and follow it up with a Viva

AIM: To should install Linux on the computer
Software Requirement: Linux software 
Hardware Requirement: Personal computer
Theory:
FEDORA Linux Installation Process:
1. LINUX BOOT OPTIONS
Actually Linux can be installed in two different modes, based on the requirement of the user.
Graphical Mode. & Text Mode.
Graphical Mode - In this you can work with Graphical Interface (i.e., it supports mouse and Icons ). 
By clicking the icon with the mouse, you can perform related action.
To install Linux in Graphical Mode Press Enter.

Text Mode - In this mode you have to interact with character based interface ( i.e., Command prompt 
). To install Linux in Text Mode Type : Linux text and Press Enter. After selecting the mode of 
installation, it goes on detecting the basic input output devices and file systems. And at last it 
displays a screen asking whether to test the CD inserted to install or to Skip the test process. 

Otherwise we can test total installation CD’s. 

On completion of testing the CD’s, it goes on loading an installation program “ANACONDA” which 
helps us in the installation of the remaining part.
 2 WELCOME TO INSTALLATION PROCESS
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It starts with the display of the welcome screen containing the online help , and four buttons to help  
us in the different activities in the installation process. 
Hide Help/Show Help - Which helps you in guiding the installation process, which can be activated 
or hidden. 
Release  Notes  -  Which  contain  the  Basic  Hardware  Requirements  that  are  necessary  for  the 
installation of the Red Linux 9.0 and some other post-installation issues. 
Next - This button allows you to go to next step of the installation process by the current step.
 Back - This button allows you to move back of the installation process to make any changes that  
previously mentioned. 
Action: click “Next” to move to next screen. 
3. SELECTING A LANGUAGE 
It displays a screen containing various languages, to select a language you would like to use during  
this installation process.

4. CONFIGURING KEYBOARD AND MOUSE 
Here we need to select our own keyboard and mouse layouts which will help you to interactively  
proceed  in  the  installation  process.  At  this  point  of  time  it  displays  you  the  different  types  of 
keyboard layouts. So that you can select your desired one that you would like to use for the system. 
And also choose the appropriate Mouse for the system, based on the following: Select the exact 
mouse type among the available.
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5. TYPE OF INSTALLATION
There are different installation types that are available which will enable you to select that will best  
meet your needs. There are four different types of installations are there –
Personal Desktop - You select it for personal computers or laptops, select this installation type to 
install a graphical desktop environment and create a system ideal for home or desktop use. 
Work  Station -  This  option  installs  a  graphical  desktop  environment  with  tools  for  software 
development and system administration. 
Server - If you would like to set up file sharing, print sharing, and web services and additional  
services.
Custom -  Select  this  installation  type  to  gain  complete  control  over  the  installation  process, 
Including software package selection and authentication preferences.:

6. PARTITIONING THE DISK 
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Partitioning the disk can be done either automatically or manually. 
AUTOMATIC PARTITIONING – By selecting automatic portioning, you will not have to use 
partitioning tools to assign mount points, create partitions, or allocate space for your installation. 
Automatic partitioning allows you to have some control concerning what data is removed from your 
system. To remove only Linux partitions remove all Linux partitions on this system. To remove all  
partitions on your hard drive, select remove all partitions on this system. To retain your current data 
and partitions, assuming you have enough free space available on your hard disk, select Keep all  
partitions and use existing free space. You can review the partitions that are automatically created 
using the check box Review (and modify if needed) the partitions created. 
MANUAL PARTITIONING – To partition manually, choose the Disk Druid partitioning Tool. For 
the manual partitioning of Linux installation you need assign disk space for the three compulsory file 
systems, they are /boot, /(root), swap /boot - This type of partition should of ext3 file system type. 
For this /boot partition a minimum of about 150MB is necessary.

Swap The swap partition should of swap file system type having a minimum of the double the RAM 
available on your system. (i.e., if, RAM is of 512MB, your swap should be a minimum of 1024MB.)
/(root) – The symbol ‘/’ stands for the root. This root partition should be a minimum of 5GB. And 
you can also increase it based on your availability to increase your system performance. To add a  
new partition Just click on the NEW button and select your mount point (i.e., directory of partition 
ex: /, /boot, /user, etc., ), select your file system type among the available i.e. Ext3, ext2, swap, vfat, 
etc., ), and you have different additional size options like Fixed Size, Fill all space up to(MB), Fill to 
maximum allowable size. And also you can make a partition to be primary partition and check for 
the bad blocks on each partition. Now we have to partition our hard disk. You can choose to let the 
Fedora installer do the partitioning, or you can do it yourself. I want to create a small /boot partition 
(less than 100 MB) with the file system ext3, a swap partition and a huge / partition (again with 
ext3):
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Now the boot loader GRUB will be installed. You can leave the default settings unchanged and click 
on Next:

7. BOOT LOADER CONFIGURATION
 The GRUB boot loader will allow you to boot other operating systems. It will allow you to select an  
operating system to boot from the list. To add another operating system. You can also add other 
operating systems that are not detected automatically. For greater system security, you can set your 
password for the boot loader. To avoid unauthorized changes to the system. You can also change the 
type of boot loader other than GRUB, among the available like LILO. And also you can avoid to 
install boot loader.

8. NETWORK CONFIGURATION 
With  this  option  you  can  set  your  Network  devices  manually  or  using  DHCP (Dynamic  Host 
Configuration Protocol) which will automatically takes default IP address, and Net mask addresses.  
The DHCP also set your Hostname.
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9. FIREWALL CONFIGURATION A firewall configuration is set between yours computer and 
network. And decides which resources of your computer are accessible by the remote users on 
the network.  On proper configuration of  firewall  we can set  different  security levels  for  the 
system. By using firewalls we can avoid any entrusted passage of data and also we can set our 
own protocol supports.

                                 
10 . ADDITIONAL LANGUAGE SUPPORT
This screen shows different additional languages for installation. These additional languages can be 
used to switch after installation process.

11. SELECTING A TIME ZONE
To set our time zone we can do it either by selecting computers physical location or by your time  
zone’s offset from Universal Time, Coordinated. This screen shows two tabs namely location and 
UTC Offset. First tab offers you the ability to configure by  location. Second tab allows to set UTC 
Offset.
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12. ROOT PASSWORD SETTINGS

The Root password is for avoiding any unauthorized access to Administration settings .

13. PERSONAL DESKTOP DEFAULTS
With this screen we can accept the default package list or we can customize the set of packages to be  
installed.
14. SELECTION OF PACKAGES TO INSTALL
On  selecting  the  customized  set  of  packages  we  can  select  our  own  selection  of  desktops, 
applications, servers, development tools and system tools to be installed among the available. And 
also we have an option to select a minimal set of packages and all the packages that are available  
which will install complete set of packages(about 1400) which will require about 4850 MB of space.

15. ABOUT TO INSTALL
This is the final step to make any modifications to the installation process. Once you
click the next button you cannot do any modifications.
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16. INSTALLING THE PACKAGES
First it formats the file systems and copies the files to our hard disk to continue installation. Then 
there starts the installing of packages which may take up to several minutes of time during which we 
need to insert next two CD ROMs to complete the installation process.

DEPART MENT OF CSE
17. CREATING A BOOT DISK
Here the prompts you to create a Linux boot disk on your choice for your further requirement.
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18. CONFIGURING YOUR DISPLAY
At this stage you need to select your video card type and monitor configuration and also you restore 
to the original values.

19. END OF INSTALLATION PROCESS At the end of the installation process it will remove all 
the media that is used by the installation. And reboots your system again. 

After the Installation:
After the installation your computer will  reboot and you will  go through a simple configuration 
procedure to get your computer ready for use. It includes such things as setting the time, setting the 
password for the "root" user, and creating other user accounts.

Click Next
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Task 5
Every student should install BOSS on the computer. The system should be configured as dual 
boot (VMWare) with both Windows and BOSS. Lab instructors should verify the installation 
and follow it up with a Viva 

AIM: To install BOSS on the computer
Software Requirement: BOSS software 
Hardware Requirement: Personal computer
Theory: 
Indian people always rely on other nations for using Operating Systems like Windows and Linux 
distributions like CentOS, Ubuntu, etc., in their computers, smartphones, and other gadgets, none of 
which were developed in India. Therefore, if we want to use an OS developed in India, then the  
BOSS operating system should be our go-to option.

BOSS  Operating  System,  also  known  as  Bharat  Operating  System  Solution,  is 
a GNU/Linux distribution that is derived from Debian Linux.

This  distribution  was  developed  in  India  by  the Centre  for  Development  of  Advanced 
Computing (C-DAC),  Chennai,  in  the  year 20062006 for  the  enhancement  of  Free/Open  source 
software used throughout the entire nation.

The National Resource Centre for Free and Open Source Software (NRCFOSS) is the key provider 
of  BOSS  GNU/Linux  OS.  It  has  an  upgraded  desktop  environment  that  supports  local  Indian 
languages.

C-DAC had a vision that the BOSS Operating System would significantly impact the digital divide 
across India since every individual will now have access to applications or software in their local 
language to use the internet and other communication technologies.

The BOSS operating system has been recommended by the Indian government for its adoption and 
implementation on the national level. It has been LSB certified (Linux Standard Base) by the Linux 
Foundation.

Note: Linux Standard Base(LSB) is  a set  of standards that  increases compatibility among Linux 
distributions.

It becomes easier for Microsoft Windows users to migrate to the BOSS operating system because of 
its exceptional features like presentation tools, document converter, All-in-One control panel, and 
also features like plug and play. BOSS operating system is designed to be easily used for Educational 
Domains with the help of EduBOSS OS, which is a variant of BOSS OS and has relevant features 
for the primary and secondary school environment.
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Till now, 9 major versions of BOSS OS have been released, which are as follows :
 1.01.0 (Tarag) released in JanuaryJanuary 20062006
 2.02.0 (Anant) released in SeptemberSeptember 20072007
 3.03.0 (Tejas) released in SeptemberSeptember 20082008
 4.04.0 (Savir) released in AprilApril 20112011
 5.05.0 (Anokha) released in SeptemberSeptember 20132013
 6.06.0 (Anoop) released in AugustAugust 20152015
 7.07.0 (Drishti) released in AugustAugust 20182018
 8.08.0 (Unnati) released in JulyJuly 20192019
 9.09.0 (Urja) released in FebruaryFebruary 20212021

How to Install the BOSS Operating System?
Before moving towards the installation part of the BOSS operating system, the system on which we 
want to install the operating system should meet the minimum requirements.
Let's have a look at the minimum system requirements:

 512512 MB of RAM.
 1010 GB of Hard Drive space.
 Processor which supports i386i386 or x86-64bitx86−64bit architecture.
 800x600800x600 pixels screen resolution.
 DVD drive (in case of installation from a DVD drive).

Now, Let's see the steps involved in installing the BOSS operating system:

 Step:1
Download the latest version of BOSS OS from download link.

 Step:2
First, make a DVD or USB device bootable with the BOSS Operating system. Then we insert the 
bootable device inside our computer and configure the system to boot from that drive by going to 
the BIOS settings.

 Step:3
When booting  starts,  a  screen  contains  options  to  install  BOSS in  the  system.  We have  to 
select Graphics  Install from the menu and then press  enter  to  boot,  as  shown in the image 
below. 
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 Step:4
Now a screen is displayed in which we have the option of English language along with local  
languages, from which we have to choose the language for installation. We will choose the most 
suitable option which suits best for us. We will choose English here and then click on continue, 
as shown in the below image.

 Step:5
We have to choose our location according to which the system detects the time zone of the 
location. We will choose India here and then click continue.  

32



 Step:6
Then  we  will  choose  the  configuration  of  the  keyboard.  Here  we  will  choose American 
English and then click continue. 

 Step:7
Now, we will have to enter the hostname for the system. The hostname is used to recognize our 
system, so we should name it carefully. Then again, click on continue to move ahead.
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 Step:8
Now we will get an option to assign the domain name to the system, but we will leave the field 
for the domain name blank. Then click continue to move ahead.

 Step:9
Now, we have to set the user's full name, which we can skip. Then click on continue, and now we 
have to set up the username and password for the system. Then again, click continue as shown 
below images.

 Step:10
The system will take some time to complete the process we have done until now. Then we will  
have to partition the disks using the entire disk or creating partitions for installation. But here, we 
will choose Guided-use entire disk. After selecting the partition scheme, click on continue. 
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 Step: 11 We have selected the disk we use for installation purposes. After selecting the disk,  
again click on continue.

 Step:12
Then we will choose All files in one partition which is recommended for the new users. We can 
select the /home/home, /usr/usr, /var/var, and /temp/temp options if we want to have a separate 
partition. Then after selecting, click on continue.

 Step:13
Now,  Click  on  option finish  partitioning  and  write  changes  to  disk and  then  click 
on continue to move ahead in the installation process.
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 Step:14
Then, on the next window, select Yes for the question "Write the changes to disk ?" and click 
on continue.

Now, we will have to install the GRUB boot loader, for which we have to select Yes and again click 
on continue.
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 Step:15
Then we will select the hard disk volume to install the GRUB boot loader, where our operating 
system is already installed. Click on continue.

 Step:16
Now the installation is completed, we will click on continue and wait for a few seconds until the 
system reboots.

 Step:17
Now, choose the operating system we want to boot into and enter the password we created 
during the installation process to start using the operating system. Now the BOSS operating 
system is ready to use.
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How to Use the Boss Operating System?
The BOSS operating system can be used the same way we use different Linux-based distributions. 
At the very start, we start the system and log in using the password we created for the user. Then we 
see the desktop of BOSS OS, which initially has icons like home,trash, etc. We can change the 
desktop's background by right-clicking on the desktop and choosing the change desktop background 
option from the menu.  We can check the computer system's specifications and information about the  
user from the system menu inside the All Settings option.

BOSS  operating  system  also  has  pre-installed  internet  browsers  like  Mozilla  Firefox  and  a 
Chromium web browser which helps in browsing the internet easily. It also has LibreOffice, which 
is used to open different documents and enables us to edit them. Maps are also available as a feature 
on the operating system.

If  we want  to install  a  new application,  this  can be done easily by downloading the apps from 
the APT repository.  We have  to  type sudo  apt-get  install  <package_name> on  the  terminal  to 
download and install new packages from the APT repository.
BOSS OS should be more than enough to carry out our everyday tasks.

Advantages of BOSS OS
Let's take a look at some of the advantages of the BOSS operating system:
 Since BOSS OS is a Linux distribution, it is Free/Open source software and free of cost. No 

licensing  or  permit  is  required  to  install  and  use  a  Linux  os;  it  can  be  used  on  numerous 
computers.

 In terms of security, Linux distributions are very safe as there are few possibilities that a Linux os 
can be infected. That is because Linux is open-source software and many engineers always watch 
out for security-related issues.

 In the case of the Windows operating system, if we install or uninstall the software, then the os 
demands a reboot, but in the case of BOSS Linux os, we don't have to reboot the system.
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 Suppose we have an old pc that has very low specifications. Even after this, we can install BOSS 
Linux os. This is because Linux has various distributions made for various PCs.

 It is easier to migrate toward the BOSS operating system from the Windows operating system 
since it provides a wide variety of features and ease of usage in Education platforms.

Disadvantages of BOSS OS
Let's take a look at some of the disadvantages of the BOSS operating system:
 One of the major issues we face with the BOSS operating system is the drivers. The equipment 

makers generally develop drivers for Windows or mac operating systems; they don't make the 
drivers for Linux OS.

 The BOSS operating system deals with the problem of insufficient software tool requirements.
 BOSS OS does not come with an application store, making it a bit uncomfortable for new users  

or those who are migrating from Windows or mac os.
 Linux  distributions  like  Ubuntu  have  a  huge  dedicated  community;  in  contrast,  no  such 

community exists for the BOSS operating system. This is a huge drawback as Linux is open-
source software and demands a community that will help beginners understand more about the 
operating system.
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Internet & World Wide Web 

Task1 

Orientation & Connectivity Boot Camp: Students should get connected to their Local Area 

Network and access the Internet. In the process they configure the TCP/IP setting. Finally 

students should demonstrate, to the instructor, how to access the websites and email. If there is 

no internet connectivity preparations need to be made by the instructors to simulate the WWW 

on the LAN.  

 

AIM: To learn Local Area Network and access the Internet. In the process they configure the TCP/IP 

setting. Finally students should demonstrate, to the instructor, how to access the websites and email 

Software Requirement: Local Area Network to access the Internet  

Hardware Requirement: Personal computer  

Theory: The internet is a worldwide, publicly network of interconnected computer networks  

 

LOCAL AREA NETWORK: LANs are privately owned networks with in a single building or 

campus of up to few kilometers in size.  

 

WIDE AREA NETWORK: A WAN is a network that connects computers across a large 

geographic area such as a city or country  

TCP/IP(Transmission Control Protocol/Internet Protocol): Collection of methods used to 

connect servers on the internet and to exchange data.  

HTML (Hyper Text Markup Language): The coding used to control the look of documents on the 

web HTTP (Hyper Text Transfer Protocol): Part of a url that identifies the location as one that uses 

HTML. 

IP (Internet Protocol): A format for contents and addresses of packets of information sent over the 

internet  

IP ADDRESS: An identifier for a computer or device on a TCP/IP network  

SEARCH ENGINE: A program that searches documents located on the Internet for keywords or 

phrases entered by a person browsing the net. 

 

Internet Connection requirements: 

• TCP/IP protocol 

• Client Software 

• ISP Account 

 

Means of communication to the net: 

• TelephoneModem 

• Ethernet 

• ISDN(Integrated Services Digital Network) 
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• DSL(Digital Subscriber Line) 

• Satellite. 

PROCEDURE: 

1. Go to start>control Panel 

2. Open Network Connections 

3. Click create a new connection and then click next 

4. The new connection wizard window opens, click next to continue 

5. Choose one of the options in the next dialog box. 

6. Choose one of the three options in the next dialog box 

7. If you do not have an internet account click choose from a list of ISPs and then click next 

8. If you have an account click Set up my connection manually 

9. If you have a CD from the ISP click use the CD I got from an ISP and then click next 

10. Follow the next steps as per the option you selected. 
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Task 2 

Web Browsers, Surfing the Web: Students customize their web browsers with the LAN proxy 

settings, bookmarks, search toolbars and pop up blockers. Also, plug-ins like Macromedia 

Flash and JRE for applets should be configured.  

 

AIM: To learn to surf the web  

Software Requirement: Local Area Network to access the Internet  

Hardware Requirement: Personal computer  

Theory:   

Web browser provides the means to the searching and also helps to Download the  web content.  

Web browsers support most of the famous Internet Protocols like HTTP, FTP. Common file formats 

a browser accepts are HTML. Well known browsers natively support a variety of other formats in 

addition to HTML such as JPEG,PNG,GIF image formats  

 

Each web browser is built-in with the support of Internet Bookmarks which serve as a named anchor 

– primarily to URLs. The primary purpose of this book mark is to easily catalog and access web 

pages that the web browser user has visited or plans to visit, without having to navigate the web to 

get there.  

 

Pop-up Blockers: Pop-ups are a form of online advertising on the WWW intended to attract the 

attention of the users. These pop ups are hosted on the web sites which are frequently visited by the 

netizens. These pop ups are activated when these web sites open a new web browser window and 

there by displaying the advertisements.  

 

Plug-ins: A plug-in is a software component program that interacts with a main application to 

provide a better integration of the media. The basic difference between application programs and 

plug-ins is that multimedia files are launched in a separate window where as in plug-ins multimedia 

play in the browser window.  

 

Few famous plug -ins are: 

1. Apple Quick Time     2.  Adobe Shockwave     3. Macromedia flash   

4. Sun Microsystems Java Applet    5. Microsoft Media Player  

LAN Proxy Settings:  

1. select tools menu in Internet Explorer  
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2. Select Internet Options  

3. Select Connections  

 
4. You end up in two options  

✓ Dial-up and virtual network settings  

✓ LAN setting  
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Select the properties button. The properties of the ipaddress, default Gateway and the DNS server 

details are reflected in the dialog box. 

 
• The selection at this step is dependent on the kind of connection you are trying to configure. 

They are:  

✓  Dial-up modem connection  

✓ LAN connection  

✓ DSL or Cable modem  
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Task 3 

Search Engines & Netiquette: Students should know what search engines are and how to use 

the search engines. A few topics would be given to the students for which they need to search 

on Google. This should be demonstrated to the instructors by the student.  

 

AIM: To know what search engines are and how to use the search engines.  

Hardware Requirements: Personal Computer  

Software Requirements: Operating System, Web Browser  

Theory:  

Search engine:  

A search engine can be defined as a web site with tools which help you to find information on the 

internet. Search Engine can the search any data based on keywords, searches on web and finding the 

locations various web sites databases with the related information and gives the different list of 

results to the Web Browser.  

 

Limitations:  

Search engines visit web sites only several weeks. Search engines cannot see information in other 

data bases later on. On the internet a search engine is a coordinated set of programs that includes: A 

spider (crawler or bot) that goes to every page or representative pages on every web site that wants to 

be searchable and reads it, using hypertext links on each page to discover and read site’s other pages.  

 

Pros:  

• You can select the search terms  

• You can use the same search terms with multiple search engines  

• You can change search terms as much as you wish  

• You will normally receive numerous links  

• Its fast  

 

Cons:  

• There are so many different search engines it may be difficult to choose  

• You will normally receive too many links often making it difficult to identify the most 

relevant sites.  

• The vast majority of links may be only marginally relevant or altogether irrelevant  

 

EX: Alta Vista, Ask Jeeves, Google, Lycos, Yahoo, Bing, Etc...  

 

Meta Search Engines:  

Meta search engines or “metacrawlers” don’t crawl the web themselves. Instead they search the 

resources of multiple search engines by sending a search to several search engines at once 

aggregating the result.  
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Pros:  

• You only need to use one search tool which is time- efficient  

• You only need to learn how to use one search engine reducing learning curve  

• You benefit from the difference among several search tools at once  

Cons:  

• Meta search services may not be able to leverage each individual search engines full range of 

query tools resulting in less refined searches  

• You can not personally select the search engines queried by Meta search services.  

Ex: DogPile, Mamma, Vivisimo, Meta Search Engine, etc.  
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Task 4 

Cyber Hygiene: Students would be exposed to the various threats on the internet and would be 

asked to configure their computer to be safe on the internet. They need to customize their 

browsers to block pop ups, block active x downloads to avoid viruses and/or worms.  

 

AIM: To learn various threats on the internet and configure the computer to be safe on the internet. 

Software Requirement: Antivirus Software 

Hardware Requirement: Personal computer 

Theory: 

Antivirus: 

Antivirus software is a program that either comes installed on your computer or that you purchase 

and install yourself. It protects your computer against most viruses, worms, Trojan horses and other 

unwanted invaders that can make your computer sick. 

 

Firewall: 

A firewall is a special software or hardware designed to protect a private computer network from 

unauthorized access. A firewall is a set of related programs located at a network gateway server 

which protects the resources of the private network from users from other networks. 

 

PROCEDURE:Installing Symantec antivirus for Windows: 

• Insert Symantec antivirus CD into your CD drive 

• Double click on the Symantec-setup.exe 

• The installer will open 

• Click next to proceed 

• License agreement will open. Click I accept the terms of the license agreement and then click 

next. 

• Follow the instruction on the screen to complete the installation. 

 

Get Computer Updates: 

• Click start> settings>control panel 

• Click Automatic Updates icon to open Automatic Updates dialog box 

• Check the box Keep my computer up to date 

• Choose a setting 

• Click OK 

 

Block Pop ups: 

• In the IE open tools>pop-up blocker 

• Click on Turn on Pop- up blocker 
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Windows Firewall: 

• Go to Start>control panel>Network and Internet Connections >windows firewall 

• In the general tab check the On(recommended) box 

• If you don‘t want any exceptions check on Don’t allow exceptions  box 
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LaTeX and WORD 

Task 1 

Word Orientation: The mentor needs to give an overview of La TeX and Microsoft (MS) office 

or equivalent (FOSS) tool word: Importance of La TeX and MS office or equivalent (FOSS) 

tool Word as word Processors, Details of the four tasks and features that would be covered in 

each, Using La TeXand word – Accessing, overview of toolbars, saving files, Using help and 

resources, rulers, format painter in word.  

 

LATEX INTRODUCTION:  

LaTeX is a family of programs designed to produce publication-quality typeset documents. It is 

particularly strong when working with mathematical symbols. The history of LaTeX begins with a 

program called TEX. In 1978, a computer scientist by the name of Donald Knuth grew frustrated 

with the mistakes that his publishers made in typesetting his work. He decided to create a typesetting 

program that everyone could easily use to typeset documents, particularly those that include 

formulae, and made it freely available. The result is TEX. Knuth's product is an immensely powerful 

program, but one that does focus very much on small details. A mathematician and computer 

scientist by the name of Leslie Lamport wrote a variant of TEX called LaTeX that focuses on 

document structure rather than such details.  

 

Required Components of LaTeX Document:  

Every LaTeX document must contain the following three components. Everything else is optional 

(even text). 

1. \documentclass{article}  

2. \begin{document}  

3. \end{document} 

 

AIM: To maintain a shift schedule with specifications  

Software Requirement: MS-WORD  

Hardware Requirement: Personal computer  

Theory:  

Rulers: It is used to change the format of the document, i.e. it helps you align the text, tables, 

graphics and other elements of your document.   

Format Painter: It is used to quickly apply the same formatting, such as color, font style and size, or 

border style, to multiple pieces of text or graphics. To choose Format Painter: On the Home tab, 

select  Format Painter in the Clipboard group.   

 

Overview of toolbars:  

• Quick Access Toolbar lies next to the Microsoft Office Button.   

• It gives you quick access to commonly used commands such as Save, Undo, Redo, etc.  
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Tabs:  

• It comprises seven tabs; Home, Insert, Page layout, References, Mailing, Review and View.   

• Each tab has specific groups of related commands. It gives you quick access to the commonly 

used commands that you need to complete a task.  

PROCEDURE:  

1. Click the start button which is located on the left-hand bottom corner on your Desktop or Laptop  

2. Click the All Programs button just above the Start button.  

3. Find the group Microsoft Office. If you point at the Microsoft Office group icon, the sub-group 

will open. If it does not, just click once with your left mouse button. 

4. In the sub-group, one of the icon will be Microsoft Office Word  
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Task 2 

Using La TeX and Word to create a project certificate. Features to be covered:- Formatting 

Fonts in word, Drop Cap in word, Applying Text effects, Using Character Spacing, Borders 

and Colors, Inserting Header and Footer, Using Date and Time option in both La TeX and 

Word.  

 

AIM: To create a document applying the above mentioned techniques.  

Software Requirement: MS-WORD  

Hardware Requirement: Personal computer 

Theory:  

Header and Footer:  

1. To create a header, enter text or graphics in the header area or click button on the header and 

footer tool bar.  

2. To create footer, click switch between header and footer.  

3. Then click exit.  

 

Date and Time:  

1. Insert a date field that automatically updates so that the current date is displayed when you open 

or print the file.  

2. Insert a time field that automatically updates so that the current time is displayed when you open 

or print the file.  

 

Border:  

1. On the format menu, click borders and shadings. 

2. To specify that the border appears on a particular side of a page, such as only at the top, click 

custom under setting. 

3. To specify a particular page or section for the borders to appear, click the option you want to 

apply.   

4. To specify the exact position of the border on the page. Finally, click OK. 

 
 

Color:   

1. Select the text you want to make a different color. 

2. To apply the color most recently applied to text, click font color. 
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3. To apply different colors, click the arrow on the right of the font color button, select the color 

you want and then click the button.  

 

PROCEDURE: 

First click start button on the status bar. Then select program and again select Microsoft word. On 

the menu bar click the file option. Then again click new. Then enter the text not less than 100 words. 

A header appears at the top and the footer appears at the bottom of each page. On the view menu, 

click header and footer option. From dialogue box, make the required changes and then click OK. On 

the format menu, click borders and shading s make required changes and the click OK. Select the 

text you want and make the different color. Click on right of the font color button, and then select the 

color you want and then click on the button.  
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Task 3 

Creating project abstract Features to be covered:-Formatting Styles, Inserting table, Bullets 

and Numbering, Changing Text Direction, Cell alignment, Footnote, Hyperlink, Symbols, Spell 

Check, Track Changes.  

 

AIM: To create a document applying the above mentioned techniques.  

Software Requirement: MS-WORD  

Hardware Requirement: Personal computer  

Theory:  

Table: A table consists of rows and columns.  

 
Cell Alignment: Aligns contents written in a table in the top left corner or top right corner or in the 

center etc...  

 
Foot Note: Foot notes are used to comments on, or provide references for text in a document. 

Hyperlink: It is a colored and underlined text or a graphic that you click to go to a file, a location in 

a file, an HTML page on the World Wide Web, or an HTML page in an intranet.  
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Symbols: You may not be able to enter certain symbols into your word document, as there is a 

limitation on the keys on the key board. Creating these new symbols especially when working with 

mathematical terms it becomes very difficult .For example we can insert symbols such as≡,≈, ,.. 

 
Spell check: It automatically checks for spelling and grammatical errors  

 
Bullets and Numbering: In Microsoft word we can easily create bulleted or numbered list of items.  
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Formatting Styles: o A style is a set of rules to be followed for the effective document. o Style can 

be applied to text, paragraph, table or a list.  

 

 
Changing text direction: You can change the text orientation in drawing objects, such as text boxes, 

shapes, and callouts, or in table cells so that the text is displayed vertically or horizontally.  

 

 
Track changes: A track change is an excellent feature of Microsoft word as it enables a user or 

reviewer to keep track of the changes that have taken a period. Changes like insertion, deletion or 

formatting changes can be kept track of.  

Procedure:  

Changing Text direction:  

1. Click the drawing object or table cell that contains the text you want to change.  

2. On the Format menu, click Text Direction.  

3. Click the orientation you want.  

 

Table:  

1. Click where you want to create a table.  

2. On the Table menu, point to Insert, and then click Table.  

3. Under Table size, select the number of columns and rows.  
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4. Under AutoFit behavior, choose options to adjust table size.  

5. To use a built-in table format, click AutoFormat. Select the options you want 

 

Cell Alignment:  

1. Click the cell that contains text you want to align.  

2. On the Tables and Borders toolbar, select the option for the horizontal and vertical alignment you 

want— for example, Align Bottom Center or Align Top Right.  

Foot Note:  

1. In print layout view, click where you want to insert the note reference mark.  

2. On the Insert menu, point to Reference, and then click Footnote.  

3. Click Footnotes or Endnotes. By default, Word places footnotes at the end of each page and 

endnotes at the end of the document. You can change the placement of footnotes and endnotes by 

making a selection in the Footnotes or Endnotes box.  

4. In the Number format box, click the format you want.  

5. Click Insert. Word inserts the note number and places the insertion point next to the note number. 

6. Type the note text.  

6. Scroll to your place in the document and continue typing.  

As you insert additional footnotes or endnotes in the document, Word automatically applies the 

correct number format.  

Hyper link: Select the text or picture you want to display as the hyperlink, and then click Insert 

Hyperlink on the Standard toolbar  

Do one of the following:  

1. Link to an existing file or web page:  

a. Under Link to, click Existing File or Web Page. 

b. In the Address box, type the address you want to link to or, in the Look in box, click the 

down arrow, and navigate to and select the file  

2. Link to a file you haven‘t created yet Under Link to, click Create New Document.  

3. In the Name of new document box, type the name of the new file.  

4. Under When to edit, click either Edit the new document later or Edit the new document now  

 

An e-mail address:  

1. Select the text or picture you want to display as the hyperlink, and then click Insert Hyperlink on 

the Standard toolbar  

2. Under Link to, click E-mail Address.  

3. Either type the e-mail address you want in the E-mail address box, or select an e-mail address in 

the recently used e-mail addresses box.  

4. In the Subject box, type the subject of the e-mail message  

 

A specific location in another document  

1. Insert a bookmark in the destination file or Web page.  
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2. Open the file that you want to link from, and select the text or object you want to display as the 

hyperlink.  

3. On the Standard toolbar, click Insert Hyperlink .  

4. Under Link to, click Existing File or Web Page.  

5. In the Look in box, click the down arrow, and navigate to and select the file that you want to link 

to.  

6. Click Bookmark, select the bookmark you want, and then click OK.  

 

Symbol:  

1. Click where you want to insert the symbol.  

2. On the Insert menu, click Symbol, and then click the Symbols tab.  

3. In the Font box, click the font that you want.  

4. Double-click the symbol that you want to insert.  

5. Click Close 

 

Spell check:  

1. On the Standard toolbar, click Spelling and Grammar .  

2. When Word finds a possible spelling or grammatical problem, make your changes in the Spelling 

and Grammar dialog box.  

 

 

Bullets and Numbering:  

1. Type 1. to start a numbered list or * (asterisk) to start a bulleted list, and then press SPACEBAR 

or TAB.  

2. Type any text you want. 

3. Press ENTER to add the next list item. Word automatically inserts the next number or bullet.  

4. To finish the list, press ENTER twice, or press BACKSPACE to delete the last bullet or number 

in the list  

 

Formatting Styles:  

1. Select the words, paragraph, list, or table you want to change. 

2. If the Styles and Formatting task pane is not open, click Styles and Formatting on the Formatting 

toolbar 

3. Click the style you want in the Styles and Formatting task pane. If the style you want is not 

listed, click All Styles in the Show box  

 

Track Changes:  

1. Open the document you want to revise.  

2. On the Tools menu, click Track Changes  
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Task 4 

Creating a Newsletter: Features to be covered:- Table of Content, Newspaper columns, Images 

from files and clipart, Drawing toolbar and Word Art, Formatting Images, Textboxes, 

Paragraphs and Mail Merge in word.  

 

AIM : Create a news Letter  

Software Requirement: MS-WORD  

Hardware Requirement: Personal computer  

Theory:  

Table of contents: Table of contents displays a list of headings in a created document. It basically 

provides an outline of the entire document created  

Newspaper columns: One can create a newspaper columns document by specifying the number of 

new letter-style column required and then adjust their width , and add vertical lines between 

columns.  

Images from files and clipart: Inserting a picture (graphic) from a file and clipart may be required 

for a document. This picture could be a scanned photograph or any other digitally produced one. This 

pictures can be modified , resized, cropped and enhanced.  

Drawing toolbar and Word Art: One can create his/her own drawings in Microsoft word. Ms word 

provides a full fledged drawing tool bar. Word Art in Microsoft word enables you to create special 

and decorative text.  

Formatting Images, Textboxes and Paragraphs: Formatting an image includes selecting 

appropriate color, size, layout and cropping. Generally the text in a document follows a standard 

orientation (line after line). A text box provides a different orientation to the text with in a document. 

It can arrange the text in anywhere and can be resized and moreover moved to any section of the 

document or even outside. 

 

When you are formatting a paragraph, you do not need to highlight the entire paragraph. Placing the 

cursor anywhere in the paragraph enables you to format it. After you set a paragraph format, 

subsequent paragraphs will have the same format unless you change the format  

 

PROCEDURE:  

Table of contents:  

1. Click where you want to insert the table of contents.  

2. On the Insert menu, point to Reference, and click Index and Tables. 

3. Click the Table of Contents tab.  

4. To use one of the available designs, click a design in the Formats box.  

5. Select any other table of contents options you want. 

 

 Newspaper columns:  

1. Select the entire or part of document to be converted into a newsletter-style  
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2. Click on format menu , select columns 

3. Any desired number of columns are presets-one or two or three or left or right b\can be selected. 

4. Width and spacing can be fixed and equal columns width can be checked for uniformity  

4. If newspaper columns are to be separated by a line, then check line between  

5. Under apply to will be whole document if entire document is selected else we have to select a 

selected text. Click ok  

 
Inserting images from files and clip art:  

1. Click where you want to insert the picture.  

2. On the Insert menu, point to Picture, and then click From File. 

3. Locate the picture you want to insert.  

4. Double-click the picture you want to insert. 

 

 CLIP ART:  

1. On the Insert menu, point to Picture, and then click Clip Art. 

2. In the Clip Art task pane, in the Search for box, type a word or phrase that describes the clip you 

want or type in all or some of the file name of the clip.  

3. To narrow your search, do one or both of the following:  

4. To limit search results to a specific collection of clips, in the Search in box, click the arrow and 

select the collections you want to search. To limit search results to a specific type of media file, 

in the Results should be box, click the arrow and select the check box next to the types of clips 

you want to find. Click Go 

5. If you don't know the exact file name, you can substitute wildcard characters for one or more real 

characters. Use the asterisk (*) as a substitute for zero or more characters in a file name. Use the 

question mark (?) as a substitute for a single character in a file name. In the Results box, click the 

clip to insert it.  
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Drawing Toolbar and Word Art:  

1. Click in your document where you want to create the drawing.  

2. On the Insert menu, point to Picture, and then click New Drawing. A drawing canvas is inserted 

into your document.  

3. Use the Drawing toolbar to add any shapes or pictures that you want  

 

WORD ART:  

1. On the Drawing toolbar, click Insert WordArt .  

2. Click the WordArt effect you want, and then click OK.  

3. In the Edit WordArt Text dialog box, type the text you want.  

4. Do any of the following:  To change the font type, in the Font list, select a font. 

✓ To change the font size, in the Size list, select a size. 

✓ To make text bold, click the Bold button. 

✓ To make text italic, click the Italic button. 

 
Formatting Images:  

1. Formatting of the images can be achieved by selecting the image and double click on the picture, 

format picture dialog box appears.  

2. The same can be achieved by selecting the tools menu > customize>tool bars tab>picture and 

click close. 



 
 

61 
 

 
Basic formatting features of an image  

Resize a drawing  

1. Select the drawing canvas  

2. On the Drawing Canvas toolbar, do one of the following:  

• To make the drawing canvas boundary larger without changing the size of the objects on the 

canvas, click Expand .  

• To make the drawing canvas boundary fit tightly around the drawing objects or pictures, click 

Fit .  

• To scale the drawing and make the objects and canvas proportionately smaller or larger, click 

Scale Drawing, and then drag the edges of the canvas.  

 

Resize a picture or shape  

1. Position the mouse pointer over one of the sizing handles  

2. Drag the sizing handle until the object is the shape and size you want.  

To increase or decrease the size in one or more directions, drag the mouse away from or toward the 

center, while doing one of the following:  

• To keep the center of an object in the same place, hold down CTRL while dragging the mouse. o 

To maintain the object's proportions, drag one of the corner sizing handles.  

• To maintain the proportions while keeping the center in the same place, hold down CTRL while 

dragging one of the corner sizing handles.  

 

Crop a picture  

1. Select the picture you want to crop. 

2. On the Picture toolbar, click Crop .  

3. Position the cropping tool over a cropping handle and then do one of the following:  

• To crop one side, drag the center handle on that side inward.  

• To crop equally on two sides at once, hold down CTRL as you drag the center handle on 

either side inward.  
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• To crop equally on all four sides at once, hold down CTRL as you drag a corner handle 

inward.  

4. On the Picture toolbar, click Crop to turn off the Crop command.  

 
Text Box:  

1. On the Drawing toolbar, click Text Box .  

2. Click or drag in your document where you want to insert the text box  

3. You can use the options on the Drawing toolbar to enhance a text box— for example, to change 

the fill color— just as you can with any other drawing object  

 

Paragraphs: Change line spacing  

1. Select the text you want to change.  

2. On the Formatting toolbar, point to Line Spacing, and then do one of the following:  

• To apply a new setting, click the arrow, and then select the number that you want.  

• oTo apply the most recently used setting, click the button.  

• To set more precise measurements, click the arrow, click More, and then select the options 

you want under Line Spacing.  

 
Change spacing before or after paragraphs  

1. Select the paragraphs in which you want to change spacing.  

2. On the Format menu, click Paragraph, and then click the Indents and Spacing tab.  

3. Under Spacing, enter the spacing you want in the Before or After box.  

 

Change paragraph direction  
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1. Place the insertion point in the paragraph that you want to change, or select several paragraphs.  

2. Do one of the following:  

• To have text begin from the left, click Left-to-Right on the Formatting toolbar.  

• To have text begin from the right, click Right-to-Left on the Formatting toolbar.  

 

When you change the paragraph direction, Microsoft Word leaves justified and centered text as it is. 

In the case of left-aligned or right -aligned text, Word flips the alignment to its opposite. For 

example, if you have a left-to-right paragraph that is right aligned, such as the date at the top of a 

letter, clicking Right-to-Left results in a right-to-left paragraph that is left aligned.  

Forms: Using Microsoft word one can create an organized and structured document with a provision 

to enter the required information into it. A document of such nature is called a form.  

 

Mail Merge: It helps us to produce from letters mailing labels envelopes catalogs and others types of 

merged document. It is so found in the tools option on the menu bar. In tools we have letters and 

mailing. In letters and mailing we have mail merge mail merge tool box envelopes tables and letters 

wizard. In mail merge select the required document you are working on. A window for customizing 

the data base structure appears. This file contains the names, address details with contact numbers etc 

of people you wish to send the letters.  

 

Inserting objects: Insert an object such as drawing word art text effects or an equation at the 

inserting point.  

Fields: It inserts a field at the inserting font fields are used to insert a variety of information 

automatically. Select table in table select insert. In that select insert table a box containing number of 

rows and columns will appear. Select six colors and four rows and click o.k. Given the first row as 

date, problem repeated student‘s signature action recommended problem status and councilors sign. 

Insert the objects in the feedback form and apply the text fields in the form.  

 

PROCEDURE:  

Mail Merge:  

1. Open a document and type the complete body of the letter and format it as required.  

2. Create a data source and choose mail merge from tool bar a window is displayed.  

3. Click on create button and choose from letter options. Then a window is displayed.  

4. Click active window choose currently active document. Click on data and create data source 

option.  

5. A window for customizing the data base structure appears and this file contains the names 

address details with contact number etc. we can add or remove fields from this file.  

6. Once the list of fields is finalized a window of same is displayed and types the required file 

names and click on save button. 

7. A window is displayed. Type the details of 10 candidates. After typing details of one person, 

click on add menu.  
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8. Click on the o.k. to finish entering the records mail merge tool bar is displayed.  

9. Place the curser at the place where you wish to insert names and click on insert mail merge 

button. A drop list is displayed all fields created would be shown.  

10. By highlighting to desired file and click on it we can insert the field into the main document and 

go to begin the mail merge click on mail merge.  

11. A window is displayed click once on the merge button to generate letters for all records in your 

data source file.  

 
 

Forms:  

1. Design the form by sketching a layout first, or use an existing form template as a guide. Tables, 

text boxes, borders, and shading are all design elements that can help you create a well-designed 

form that's easy to use.  

2. On the Standard toolbar, click New Blank Document .  

3. Add the text or graphics you want. For example, enter the questions you want answered, and list 

the available choices.  

4. To insert a text box where users can enter their responses, click the document, and then click 

Text Form Field on the Forms toolbar. If you need more space, you can insert multiple text boxes 

side by side. To insert check boxes that list choices, such as Yes and No, click the document, and 

then click Check Box Form Field on the Forms toolbar. Save the form 

 

Insert line numbers:  

1. On the File menu, click Page Setup, and then click the Layout tab.  

2. In the Apply to box, click Whole document.  

3. Click Line Numbers.  

4. Select the Add line numbering check box, and then select the options you want.  
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EXCEL 

Excel Orientation: The mentor needs to tell the importance of MS office or equivalent (FOSS) 

tool Excel as a Spreadsheet tool, give the details of the four tasks and features that would be 

covered in each. Using Excel – Accessing, overview of toolbars, saving excel files, Using help 

and resources.  

Task 1 

Creating a Scheduler - Features to be covered: Gridlines, Format Cells, Summation, auto fill, 

Formatting Text  

 

AIM: To maintain a shift schedule with specifications  

Software Requirement: MS-EXCEL  

Hardware Requirement: Personal computer  

Theory:  

Grid lines:  

1. Click the worksheet.  

2. On the file menu, click page setup and the click the sheet tab.  

3. Click gridlines.  

4. Select the sheets on which you want to change the gridlines  

color.  

5. On the Tools menu click options click the color you want 

6. in the color box. To use the default gridlines color click  

automatic.  

7. Lines you can add to a chart that make it easier to view and  

evaluate data. Gridlines extend from the tick marks on an axis across a plot area.  

 

Format Cell: 

1. Change the font and font size.  

2. Change the text color.  

3. Make selected text or numbers bold, italic or  

underlined.  

4. Create a new style.  

 

Auto fit: 

1. Combine cells horizontally or vertically to make one large cell.  

2. Add borders to cells. 

3. Shade cells with colors.  

4. Change the column width and row height  

5. Change the font, font size or colors of text.  

6. Align text vertically at the top, center and bottom of cell 
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Formatting the text:  

1. Select the text you want to format. 

2. On the format menu click cells and then click number tab.  

3. In the catalog box click text.  

4. Enter the numbers in the formatted cells.  

5. Click ok.  

6. Then press enter and reenter the data.  

 
PROCEDURE:  

First click start button of the screen on status bar. Click on programs and then Microsoft excel. To 

get a new blank work sheet go to programs and then click on excel sheet. On the file menu click page 

setup and then click sheet tab click gridlines. In this way do the required changes using format cell, 

make the required changes using formatting text also make the required changes. Enter the data in 

the data in the worksheet consisting of week name person name and timings 7 a.m. to 3 p.m. Make 

all the above changes to the text.  
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Task 2 

Calculating GPA. Features to be covered:- Cell Referencing, Formulae in excel – average, std. 

deviation, Charts, Renaming and Inserting worksheets, Hyper linking, Count function 

 

AIM: To maintain a control chart for printing books with given data.  

Software Requirement: MS-EXCEL  

Hardware Requirement: Personal computer  

Theory:  

1. On the chart menu click chart type 

2. Text direction. Click the arrow down next to the text direction button. For right to left click right 

to left. For left to right reading order, click left to right. For reading order that is consistent with 

the language of the first entered character, click context. For reading order that is inconsistent 

with the language of the first entered character, click control. 

3. In the tools menu click options and then click chart tab. 

4. To show all worksheet data in the chart even if some rows and columns are hidden, clear the plot 

visible cells by check box 

5. To prevent hidden rows and columns from displaying in the chart, select the plot cells only check 

box.  

 

Hyper Linking: 

1. Create a worksheet: On the file menu, click new, and then click blank workbook task pane.  

2. Insert a worksheet: Click worksheet on the insert menu. Right click on sheet tab and then click 

insert double click the template for the type of sheet you want. 

3. Hyperlink: Using hyperlink we can insert one more sheet in the present sheet  

4. Count function: Create a blank worksheet press control +c. In the worksheet select cell A and 

press control +c. On the tools menu point to formula auditing and then click formula auditing 

menu.  

 

Worksheet: 

1. In the file menu go to menu then a new worksheet is created.  

2. To add a single worksheet, click worksheet on the Insert menu. To add multiple worksheets hold 

down shift and then click the number of worksheet tasks to add in an open workbook  

 

Sort:  

1. Click a cell in the list you want to sort.  

2. On the Data menu click sort.  

3. Under first key sort click the custom sort order you want and then click ok. 

4. Click any other sorting option you want.  

 

PROCEDURE:  
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Formulae in Excel: First click on start button at the bottom of the screen on status bar. Click on 

programs and then on Microsoft excel. Then open a new document. Give the main heading and 

subheading by changing the size so that they look in block letters. Enter the data. To calculate go to 

Insert menu in the menu bar and then click on function and then ok. Then select the data to which 

you want to calculate mean. Then you get the required answer. In same way, sample means standard 

deviation lower count limit and upper count limit. Go to insert menu and click on function and select 

the required operation to be done and select the data and calculate. Formulas for all the above are 

given below.  

Mean = (s1 + s2 + s3 + s4 + s5)/5;  

Sample mean = avg (mean)  

Standard deviation = (mean, sample, mean)  

Sample standard deviation= avg (Standard deviation)  

Lower count limit = sample mean – sample standard deviation.  

Upper count limit = Sample mean + Sample Standard deviation  

 

Hyper linking: First click on start button of the screen on status bar. Click on programs and then 

Ms-excel. To get a new blank worksheet go to programs and then click on excel sheet. Rename the 

first sheet as student by right clicking on sheet 1 and renaming. Insert hyperlink insert and click on 

hyperlink. Then go to sheet 2 and rename as CSE type in particulars of ECE right click on sheet 3. 

Then go to sheet -4 rename as IT. In this type all the four sheets are created.  

 

WORKSHEET  

First click on start button at the bottom of the screen on status bar. Click on programs and then Ms-

excel. Then enter the data as given. Enter the student‘s names, Subjective wise marks, total and avg. 

Then calculate the total and avg by using formula. Then go to Data menu and click sort. Under first 

key sort, click custom sort order needed i.e. ascending order or alphabetical order and then click o.k. 

Then the required worksheet is prepared.  

 

Count Function  

Some of the content in this topic may not be applicable to some languages.  

1. To count words in selected text only, select the text you want. If you don't select any text, 

Microsoft Word counts the words in the whole document.  

2. On the Tools menu, click Word Count. Word displays counts for words, paragraphs, lines, and 

characters.  

3. To add or remove footnotes and endnotes from the count, select or clear they Include footnotes 

and endnotes check box.  

 

VLOOKUP and HLOOKUP Functions  

This document explains the functions of VLOOKUP and HLOOKUP and how to use them in a 

spreadsheet. It can be used in all versions of Microsoft Excel. VLOOKUP and HLOOKUP are 
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functions in Excel that allow you to search a table of data and based on what the user has supplied 

and give appropriate information from that table. If you have a table of Student ID numbers, Student 

Names and Grades, you can set up Excel so that if a Student ID number is supplied by the user, it 

will look through the table and output the student's name and grade. 

 
 

VLOOKUP allows you to search a table that is set up vertically. That is, all of the data is set up in 

columns and each column is responsible for one kind of data. In the Student Record example, there 

would be a separate column of data for Student Names, one for Student ID numbers, etc.  

HLOOKUP is the exact same function, but looks up data that has been formatted by rows instead of 

columns. 

 
 

The format of the VLOOKUP function is:  

VLOOKUP (lookup _value, table _array, col _index _num, range _lookup)  

The lookup _value is the user input. This is the value that the function uses to search on. If you are 

searching a table by the Student ID number, then the lookup _value is the cell that contains the 

inputted Student ID number being looked up.  

The table _array is the area of cells in which the table is located. This includes not only the column 

being searched on, but the data columns for which you are going to get the values that you need. 

Back to the example, the table_array would not only include the Student ID number column, but the 

columns for the Student Names and Grades as well.  

The col _index _num is the column of data that contains the answer that you want. If your table is 

set up as: column 1 - Student ID Number, column 2 - Student Names, column 3 - Grades and you 

inputted a Student ID Number and you want to retrieve the grade that was received for that person, 

the col _index _num would be 3. 3 is the column number of the data column for the ANSWER that 

you are trying to look up.  
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Range _lookup is a TRUE or FALSE value. When set to TRUE, the lookup function gives the 

closest match to the lookup _value without going over the lookup _value. When set to FALSE, an 

exact match must be found to the lookup _value or the function will return #N/A. Note, this requires 

that the column containing the lookup _value be formatted in ascending order.  

To use the Function Wizard to insert a VLOOKUP function:  

1. Select the cell that will contain the answer to the VLOOKUP and select Insert -> Function...  

2. Under the Function Category, choose either All or Lookup & Reference. 

3. Under the Function Name, select VLOOKUP, and hit OK. 

 

 

 
 

4. The Function Wizard for VLOOKUP will then display. The 4 values talked about above (lookup 

range_lookup) are required by the function. Each line for each value required. If you put the 

cursor into the first line for lookup down below it explains what the lookup Similar information 

is displayed when the cursor is in any of the other fields. 

 
5. Enter in the lookup _value either by typing in by selecting the cell on the worksheet. 

6. Enter in the table _array by typing in the numbers for the cells, or, by selecting the group of cells 

on the worksheet.  

7. Enter in the number for column which contains the data that you obtain in the col _index _num 

area.  

8. Enter into the range _lookup field the value TRUE if the function should accept the closest value 

to your lookup _value without going over or FALSE if an exact match is required.  

9. Hit OK when ready. 
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Task 3 

Split cells, freeze panes, group and outline, Sorting, Boolean and logical operators, Conditional 

formatting  

 

AIM: To create Excel with split cells, freeze panes, group and outline, sorting, Boolean and logical 

operators, conditional formatting 

Software Requirement: MS-EXCEL  

Hardware Requirement: Personal computer  

Theory: 

 

Split Cells: Excel allows you to split the workbook window into two horizontal or vertical panes and 

also to split cells or data across many cells.  

Sort:  

1. Click a cell in the list you want to sort.  

2. On the Data menu click sort.  

3. Under first key sort click the custom sort order you want and then click ok. Click any other 

sorting option you want  

 

Freeze Panes: You can freeze a pane from a split window or just freeze rows or columns without 

splitting the window.  

PROCEDURE:  

Sort: First click on start button at the bottom of the screen on status bar. Click on programs and then 

Ms-excel. Then enter the data as given. Enter the student’s names, Subjective wise marks, total and 

avg. Then calculate the total and avg by using formula. Then go to Data menu and click sort. Under 

first key sort, click custom sort order needed i.e. ascending order or alphabetical order and then click 

o.k. Then the required worksheet is prepared  

Split cells:   

 
Spread the content of one cell over many cells  

1. Copy the data you want into the upper-leftmost cell within the range. 

2. Select the cells you want to merge.  

3. To merge cells in a row or column and center the cell contents, click Merge and Center on the 

Formatting toolbar.  
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Split merged cells  

1. Select the merged cell When cells have been combined, Merge and Center on the Formatting 

toolbar is selected  

2. Click Merge and Center on the Formatting toolbar.  

 
Divide text across cells  

1. Select the range of cells that contains the text values. The range can be any number of rows tall, 

but no more than one columns wide.  

2. On the Data menu, click Text to Columns. 

3. Follow the instructions in the Convert Text to Columns Wizard to specify how you want to 

divide the text into columns. 

 
 Split Windows:  

1. At the top of the vertical scroll bar or at the right end of the horizontal scroll bar, point to the split 

box.  

2. When the pointer changes to a split pointer, drag the split box down or to the left to the position 

you want. 

 

 Freeze Panes:  

1. To freeze a pane, do one of the following: The top horizontal pane Select the row below where 

you want the split to appear. The left vertical pane Select the column to the right of where you 

want the split to appear. Both the upper and left panes Click the cell below and to the right of 

where you want the split to appear.  

2. On the Window menu, click Freeze Panes.  

Outline: 

1. Outline the data automatically  

1. Select the range of cells you want to outline. To outline the entire worksheet, click any cell 

on the worksheet.  

2. On the Data menu, point to Group and Outline, and then click Auto Outline. Outline the data 

manually  
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3. Select the rows or columns that contain detail data.  

4. On the Data menu, point to Group and Outline, and then click Group. The outline symbols 

appear beside the group on the screen.  

5. Continue selecting and grouping detail rows or columns until you have created all of the 

levels you want in the outline.  

 
Group: Group objects  

1. Select the objects you want to group. To select multiple objects, hold down SHIFT while you 

select each object.  

2. On the Drawing toolbar, click Draw, and then click Group.  

 

Ungroup objects  

1. Select the group you want to ungroup.  

2. On the Drawing toolbar, click Draw, and then click Ungroup. To continue ungrouping, click Yes 

when the message box appears. To change an individual object, continue to select and ungroup 

objects until the one you want becomes available.  

3. Use the tools on the Drawing toolbar to change the object  

 

Conditional Formatting:  

1. Select the cells for which you want to add, change, or remove conditional formatting  

2. On the Format menu, click Conditional Formatting. 

3. Do one of the following: Add a conditional format  

1. Do one of the following: To use values in the selected cells as the formatting criteria, click 

Cell Value Is, select the comparison phrase, and then type a constant value or a formula. If 

you enter a formula, start it with an equal sign (=). To use a formula as the formatting 

criteria (to evaluate data or a condition other than the values in selected cells), click Formula 

Is and then enter the formula that evaluates to a logical value of TRUE or FALSE.  

2. Click Format.  

3. Select the formatting you want to apply when the cell value meets the condition or the 

formula returns the value TRUE.  

4. To add another condition, click Add, and then repeat steps 1 through 3. You can specify up 

to three conditions. If none of the specified conditions are true, the cells keep their existing 

formats  
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Change or remove a conditional format  

1. Do one or more of the following:  

2. To change formats, click Format for the condition you want to change. 

3. To reselect formats on the current tab of the Format Cells dialog box, click clear and select new 

formats.  

4. To remove one or more conditions, click Delete, and then select the check box for the conditions 

you want to delete 
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POWER POINT 

Task 1 

Students will be working on basic power point utilities and tools which help them create basic 

power point presentations. PPT Orientation, Slide Layouts, Inserting Text, Word Art, 

Formatting Text, Bullets and Numbering, Auto Shapes, Lines and Arrows in PowerPoint.  

 

TITLE: Create a power point presentation consists of slide layouts inserting text, formatting text, 

bullets and numbering of five slides with following information’s. 

 Slide 1 – contents  

Slide 2 – Name  

Slide 3 – Address  

Slide 4 – Hobbies  

Slide 5 – Friends  

AIM: To maintain a PowerPoint presentation with some specifications  

Theory:  

 

SLIDE LAYOUT:  

1. On the format menu, click slide layout.  

2. On the slides tab in normal view, select the slides; you want to 

apply a layout too.  

3. In the slide layout task pane, point to layout you and then click 

 it.  

4. A new slide can also be inserted within the task pane. Point the  

layout you want the slide to have, click the arrow and then click 

       the insert new slide.  

 

 

INSERT TEXT:  

1. Text can be added to layout.  

2. Align text in the top, middle or bottom of a cell. 

3. Align text on the right or left, or in the center of a cell.  

4. Change cell margins.  

5. Insert a tab in a table.  

6. To make the symbol command available, in normal view, place 

 the insertion point on the outbox tab or in a text place holders 

 on the slide. 

7. On the insert menu, click symbol.  

8. To change fonts, click a name in the font box.  

 

FORMATTING TEXT:  
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1. Select the text you want to format as superscript or subscript. 

2. On the format menu, click font.  

3. To show or hide text formatting, on the standard toolbar, click show formatting.  

 
BULLETS AND NUMBERINGS:  

1. Select the lines of text that you want to add bullets or numbering to.  

2. Click bullets or numbering.  

 
AUTOSHAPES:  

1. Select the auto shape that has the text you want to position.  

2. Double-click the selection rectangle of the auto shape or text box and then click the text box tab 

in the format dialog box.  

3. In the text anchor point box, click the position you want the text to start in.  

 
LINES AND ARROWS:  

1. In Microsoft power point, double click the chart.  

2. Double click the chart item you want to change.  

3. On the patterns tab, do one or both of the following.  

4. To change the colors, patterns or lines, select the options you want.  
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5. To specify a fill effect, click fill effect and then select the options you want on the gradient, text 

patterns or picture tabs. To return to the slide, click outside the about  

 
PROCEDURE: 

First click on start button at the button of the screen on status bar. Click on programs and then 

Microsoft PowerPoint. Go to file and new. Then you find different pattern of slides on right side of 

your screen. Then select which is completely empty. Then enter the contents in the first slide as per 

given information, name in the second slide, Address in the third slide, Hobbies in the fourth slide 

and friends in the fifth slide. Except first slide, all the second, third, fourth, fifth slides should be 

inserted. When you select pattern of slide from a new slide, on slide which you selected you will find 

an arrow towards its right side, click that arrow and then again click insert slide. Then save it. Then 

adjust the layout. Then format the text then give bullets or numbering to the text if required. Go to 

auto shapes. Select more auto shapes and insert wherever required. Then again go to insert option 

and select new slides. And select chart and a chart with datasheet appear. Give the name, roll no, 

marks in three subjects and calculate the total. Then save the file.  
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Task 2 

Interactive presentations - Hyperlinks, Inserting –Images, Clip Art, Audio, Video, Objects, 

Tables and Charts.  

 

AIM: To maintain a PowerPoint presentation using some specifications  

THEORY:  

HYPERLINK:  

1. Select the text or object that you want to represent the hyperlink.  

2. Click insert hyperlink.  

3. Under link to, click place in this document.  

 

INSERT IMAGES:  

1. Click where you want to insert the picture.  

2. On the drawing tool bar, click insert picture.  

3. Locate the folder that contains the picture that you want to insert, and then click the picture file.  

 
CLIP ART:  

1. On the insert menu, point to structure and then click clipart.  

2. In the clipart task pane, in the search for box, type a word or phrase that describes the clip, you 

want to type in all or some of the file menus of the clip.  

3. In the results box, click the clip to insert it.  

 
AUDIO VIDEO OBJECTS:  
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1. On the slide show menu, click setup show. Under performance check box. If your computer has 

their capability, office PowerPoint will attempt to use it.  

2. Animation performance will be much better with a video card that has Microsoft direct  

 
3D. CHART:  

1. Click the slide where you want to place the embedded object.  

2. On the insert menu, click chart.  

3. Click a cell on the data sheet and then type the information you want To return to the slide, click 

outside the chart  

 
PROCEDURE:  

First click on start button at the bottom of the screen on status bar. Click on programs and then 

Microsoft power point goes to file menu. Then you find different pattern of slides on right side of 

your screen. Then select which is completely empty. Then enter the name of your college in bold 

letters. Address of your college in bold letters in the second slide. List of all the available courses in 

the third slide, extra co-curricular activities in the fourth slide except first slide, all the second, third, 

fourth slide should be inserted. When you select pattern of slide from a new slide, on slide which you 

selected, you will find an arrow towards it right side click that arrow and then again click insert slide. 

Then save it the select the slide show and then select the view show option. Then review the 

presentation in slide show by selecting next and after completing the slide show then click end show. 

Click on start button at the button of the screen on status bar, click on programs and then Microsoft 

power point. Go to file menu. On insert menu and select table option and give no. of rows and no. of 

columns and give the name, Roll no and marks in three subjects and find the total  

TEST DATA: No Test data for this Experiment 

 ERROR: No Errors for this Experiment  

RESULT: A Power Point Presentation is created by applying the above mentioned techniques 
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Task 3 

Master Layouts (slide, template, and notes), Types of views (basic, presentation, slide slotter, 

notes etc), and Inserting – Background, textures, Design Templates, Hidden slides.  

AIM: To maintain a Master Layouts in PowerPoint presentation using some specifications  

Theory: 

Introduction 

You may have noticed that when you select a different theme in PowerPoint, it rearranges the text on 

your slides and adds shapes to the background. This is because each theme has built-in slide layouts 

and background graphics. You can edit these layouts with a feature called Slide Master view. Once 

you learn how to use Slide Master view, you'll be able to customize your entire slide show with just a 

few clicks. 

What is Slide Master view? 

Slide Master view is a special feature in PowerPoint that allows you to quickly modify the slides and 

slide layouts in your presentation. From here, you can edit the slide master, which will affect every 

slide in the presentation. You can also modify individual slide layouts, which will change any slides 

using those layouts. 

 

For example, let's say you find a theme you like but you don't like a few of the slide layouts. You 

could use Slide Master view to customize the layouts to look exactly the way you want. 

 
slide master view 

In Slide Master view, the Slide Master tab will appear first on the Ribbon, but you'll still be able to 

access commands on different tabs as you normally would. 

Using Slide Master view 

Whether you're making significant changes to your slides or just a few small tweaks, Slide Master 

view can help you create a consistent, professional presentation without a lot of effort. You could use 

Slide Master view to change just about anything in your presentation, but here are some of its most 

common uses. 
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• Modify backgrounds: Slide Master view makes it easy to customize the background for all of 

your slides at the same time. For example, you could add a watermark or logo to each slide in 

your presentation, or you could modify the background graphics of an existing PowerPoint 

theme. 

• Rearrange placeholders: If you find that you often rearrange the placeholders on each slide, you 

can save time by rearranging them in Slide Master view instead. When you adjust one of the 

layouts in Slide Master view, all of the slides with that layout will change. 

• Customize text formatting: Instead of changing the text color on each slide individually, you 

could use the Slide Master to change the text color on all slides at once. 

• Create unique slide layouts: If you want to create a presentation that looks different from 

regular PowerPoint themes, you could use Slide Master view to create your own layouts. Custom 

layouts can include your own background graphics and placeholders. 

• Some overall presentation changes—like customizing the theme fonts and theme colors—can be 

made quickly from the Design tab. Review our lesson on Modifying Themes to learn more. 

 

To make changes to all slides: 

If you want to change something on all slides of your presentation, you can edit the Slide Master. In 

our example, we'll add a logo to every slide. If you'd like to work along with our example, right-click 

the image below and save it to your computer. 

• Select the View tab, then click the Slide Master command. 

 

• The presentation will switch to Slide Master view, and the Slide Master tab will be selected on 

the Ribbon. 

• In the left navigation pane, scroll up and select the first slide. This is the slide master. 
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• Make the desired changes to the slide master. In our example, we’ll insert a picture of the 

Mongibello logo. 

 

• Move, resize, or delete slide objects as needed. In our example, we'll resize the logo and move it 

to the bottom-right corner. 

 

• When you’re finished, click the Close Master View command on the Slide Master tab. 

 

• The change will appear on all slides of the presentation. 

 
Customizing slide layouts 

You can use Slide Master view to modify any slide layout in your presentation. It's easy to make 

small tweaks like adjusting background graphics and more significant changes like rearranging or 
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deleting placeholders. Unlike the slide master, changes to a slide layout will only be applied to slides 

using that layout in your presentation. 

 

To customize an existing slide layout: 

In our example, our newly added logo is hidden behind the photo in the Picture with Caption Layout. 

We'll customize this layout to make room for the logo. 

 

• Navigate to Slide Master view. 

 

• Locate and select the desired layout in the left navigation pane. You can hover the mouse over 

each layout to see which slides are currently using that layout in the presentation. 

 

• In some layouts, the background graphics may be hidden. To show the graphics, uncheck the box 

next to Hide Background Graphics. 

 

• Add, move, or delete any objects as desired. In our example, we'll delete the gray background 

shape. 
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• If you want to change the arrangement of the placeholders, you can move, resize, or delete 

any of them. In our example, we'll move our text placeholders and the black bar to the 

right side, and the photo placeholder to the left side. 

 

• When you're finished, click the Close Master View command on the Slide Master tab. 

 

• All slides using the layout will be updated. 

 

You can also move placeholders on the slide master, which will move the placeholders on multiple 

slide layouts at the same time. However, some slide layouts may still need to be adjusted manually. 

TEST DATA: No Test data for this Experiment 

 ERROR: No Errors for this Experiment  

RESULT: A Power Point Presentation is created by applying the above mentioned techniques 
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AI TOOLS – Chat GPT 

Task 1 

Prompt Engineering: Experiment with different types of prompts to see how the model 

responds. Try asking questions, starting conversations, or even providing incomplete sentences 

to see how the model completes them.  

 Ex: Prompt: "You are a knowledgeable AI. Please answer the following question: What is 

the capital of France?"  

 

AIM: To maintain a with different types of prompts to see how the model responds 

Theory: 

ChatGPT is highly versatile and can be used in various natural language processing (NLP) 

applications. Its ability to generate text based on a given prompt has garnered significant attention, 

and it’s poised to revolutionize how we interact with machine learning models. It can be used for a 

wide range of tasks, from answering questions and generating content to providing 

recommendations. However, under the hood ChatGPT is trained on an extensive dataset that includes 

parts of the internet, books, and various text sources. During training, it learns to understand and 

generate human-like text by predicting the next word in a sentence, given the preceding context. 

 

Key Considerations for Effective Prompt Engineering 

Clarity : A good prompt should be clear and easily understood, leaving no room for ambiguity. 

Example: Unclear — “What’s that?” Clear — “Could you explain the concept of string theory?” 

 

Specificity : A specific prompt clearly conveys what information or response is expected from the 

model. 

Example: Vague — “I need details.” Specific — “Please provide information on the economic 

impact of renewable energy in the United States.” 

 

Politeness : Being polite and respectful in your interaction, which can lead to more favorable 

responses. 

Example: Impolite — “Answer this immediately!” Polite — “Could you kindly share your insights 

on this topic?” 

 

Structure : Organizing your prompt in a logical and coherent manner, especially for complex or 

multi-part questions. 

Example: Unstructured — “Tell me about dogs food, cats behavior.” Structured — “Please provide 

information about dog food and describe common cat behaviors.” 

 

Relevance : Ensuring that your prompt is directly related to the topic or task at hand. 

Example: Irrelevant — “Explain climate change using baking recipes.” Relevant — “Discuss the 

impact of climate change on polar ice caps.” 

 

Openness : Allowing room for creative or flexible responses, when appropriate, to encourage more 

diverse answers. 
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Example: Restrictive — “Provide a one-word answer for the capital of France.” Open — “Tell me 

interesting facts about France, its culture, and history.” 

 

Prompting Techniques 

Prompting Techniques are strategies or methods used to effectively communicate with ChatGPT, 

ensuring you receive the desired responses. These techniques can enhance the quality and relevance 

of the model’s output. 

 

Zero-shot, One-shot, and Few-shot Prompting 

This technique revolves around the idea of providing varying degrees of context or example output 

snippets within a prompt to guide the model’s response. Providing examples can help fine-tune the 

result tone, style, & content. 

 

a. Zero-shot Prompting: 

In zero-shot prompting, you provide a prompt to ChatGPT without any explicit examples or 

reference output. 

Use Cases: Zero-shot prompting is useful when you want ChatGPT to generate responses entirely 

based on its pre-trained knowledge and the context you provide in the prompt. It can be employed for 

general questions, creative writing, and basic language understanding tasks. 

 
b. One-shot Prompting: 

One-shot prompting involves offering a single example or reference output snippet as part of the 

prompt. 

Use Cases: One-shot prompting is beneficial when you have a specific style, tone, or content in mind 

that you want ChatGPT to emulate. By providing one example, you guide the model to generate 

responses similar to the given output. This is useful for generating content consistent with your 

writing style or for instances where you have a particular reference to follow. 

 
c. Few-shot Prompting: 

Few-shot prompting extends one-shot prompting by including a few (typically more than one) 

example output snippets within the prompt. 

Use Cases: Few-shot prompting is particularly valuable when you need ChatGPT to understand and 

mimic a combination of different styles, tones, or content. By providing multiple examples, you can 

help the model grasp a broader range of references, which is especially useful for tasks that require 

adaptability and nuanced responses. It can be used in content generation, where you want the model 

to incorporate various elements, or in text summarization, where you want the model to extract the 

most important points from diverse sources. 
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Ask-Before-Answer prompting 

The “ask-before-answer” prompting technique is a method used to instruct ChatGPT to seek 

clarification or ask questions before delivering a response. It is designed to enhance the specificity 

and relevance of the generated content. This approach involves defining a role, setting a goal, 

specifying constraints, and providing extra information in the prompt. What sets it apart is the 

instruction to the model to ask for additional details or clarifications before finalizing the response. 

 

This technique offers several benefits, including precision, contextual relevance, and improved 

content quality. It is particularly valuable in tasks where a deep understanding of the subject matter is 

essential. It allows you to actively guide the model and use your expertise to ensure more accurate 

and informed outputs. 

 
Perspective prompting 

The core concept here is to allow ChatGPT to adopt various viewpoints as it generates its responses 

and outputs. By default, ChatGPT typically provides responses without any specific perspective. 

However, with this technique, you can instruct ChatGPT to adopt a defined viewpoint, such as 

creating a travel plan from the perspective of a yoga trainer. This results in entirely different 

responses tailored to that perspective. 

 

The process involves assigning roles, which effectively implements perspective prompting, 

providing a distinct perspective for generating the response. Moreover, you can take it a step further 

by employing multiple perspectives in your prompts. This approach allows ChatGPT to engage in 

discussions or create distinct plans for different individuals with varying needs and preferences. 

 

The key concept behind perspective prompting is to understand that you can guide ChatGPT to adopt 

different viewpoints. This flexibility — whether through role assignments, responses without a 
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specific perspective, or multiple perspectives — proves invaluable in addressing specific scenarios, 

facilitating discussions, or tackling multifaceted topics. 

 
Default — No perspective 

 

 
Single perspective 

 

 
Multiple perspective 

Contextual prompting 

Contextual prompting involves providing the model with extra context, such as historical 

background, cultural details, or current events, when writing prompts. This extra information helps 

ChatGPT generate responses that are more contextually aware and relevant to the specific query. 

 

Contextual prompting is particularly useful when the context significantly influences the response, 

resulting in more accurate and informed answers. However, it should be used selectively, as 

excessive context can complicate the model’s understanding. 

 
 

 Ex: Prompt: "You are a knowledgeable AI. Please answer the following question: What is 

the capital of France?"  
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TEST DATA: No Test data for this Experiment 

 ERROR: No Errors for this Experiment  

RESULT: A chatgpt output will be generated 
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Task 2 

Creative Writing: Use the model as a writing assistant. Provide the beginning of a story or a 

description of a scene, and let the model generate the rest of the content. This can be a fun way 

to brainstorm creative ideas  

 Ex: Prompt: "In a world where gravity suddenly stopped working, people started floating 

upwards. Write a story about how society adapted to this new reality."  

 

AIM: To Use the model as a writing assistant 

Theory: 

ChatGPT is a hot topic, but is it relevant to Creative Writing? Creative Writing is a craft that requires 

inspiration, imagination, and a lot of hard work. But would writers embrace a tool that could help 

them generate ideas, overcome writer’s block, and even write entire scenes? 

Can creative writers use ChatGPT to help them create original fiction? 

Creative writers could use it for new, original ideas or even fiction. However, keep in mind that 

ChatGPT is simply a tool. It’s up to the writer to use it creatively and effectively. It is also important 

to note that ChatGPT wasn’t explicitly designed for Creative Writing. Therefore, it may be better 

suited for generating ideas or providing inspiration rather than writing complete works of fiction. 

 

It is important to note that while ChatGPT can be a helpful tool for generating ideas and providing 

inspiration, it is ultimately up to the writer to use their creativity and judgment to develop and shape 

those ideas into a finished work. But there are a few ways that a creative writer could use ChatGPT 

to generate ideas for inspiration: 

 

Prompting. 

A writer could give ChatGPT a prompt, such as a character or a setting. Then, they can use the 

model’s responses to inspire a story or poem. For example, enter the following prompt. “A soldier 

returning home from war.” And use the answers to generate ideas for characters, plot points, and 

conflicts. Also, a writer could use ChatGPT to generate lists of words or phrases and use them as 

inspiration for writing exercises, such as freewriting, poetry, or character development. 

 

Freewriting. 

A writer could use ChatGPT as a writing partner and engage in a ‘freewriting’ session, where the 

writer writes whatever comes to mind without worrying about grammar, structure, or other 

conventions. ChatGPT would respond with related ideas. This can be an excellent way to get the 

creative juices flowing. Freewriting can be done with a specific prompt or theme in mind, or it can be 

entirely open-ended. Many writers find freewriting helpful for starting a writing project or 

overcoming writer’s block. 

 

Brainstorming. 

A writer could use ChatGPT as a brainstorming tool, asking it questions and using its responses to 

generate ideas and explore different possibilities. 
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While ChatGPT is not a content writing tool, it can be used to assist in the content writing process. 

ChatGPT is particularly useful for conducting research and generating new ideas and outlines, as it 

can quickly come up with answers and provide suggestions. 

 

We’ll go into more detail on the use cases of ChatGPT in content writing in the next section. But 

before we do, it’s important to know its limitations for creating quality content. 

 

ChatGPT is not designed to produce content optimized for search engines. So you will have to 

research and implement keywords for on-page SEO. Moreover, ChatGPT may generate repetitive 

ideas and phrases. You will need to provide detailed writing prompts to create content that meets 

your requirements.  

 

Therefore, it might not be the best tool for creating long-form SEO content. For long-form content, 

use AI content generators that are designed to write articles for search engines - we’ll dive more into 

that below. 

 

A more apt use of ChatGPT for content writing is to use the tool for short-form content like ads and 

landing page copy, social media posts, and even email subject lines.  

 

Also, note that the content that ChatGPT generates may not always be entirely accurate or 

appropriate. Its knowledge is limited to what has been published in the media and on the internet - up 

to September 2021 for the users of the free version (GPT 3.5) and up to April 2023 for the ones with 

access to GPT-4.  

 

In any case, you should review the content generated by ChatGPT or any AI tool to ensure its quality 

and accuracy before publishing it. 

 

8 ways to use ChatGPT for content writing 

ChatGPT has several applications for research, summaries, and even data analysis. In marketing, it’s 

primarily used to write blog posts, social media captions, and short-form marketing material.  

 

Here are 8 ways to use ChatGPT to write content. 

 

1. Generate article outlines 

ChatGPT can be used to generate article outlines by providing suggestions for subtopics or sections 

based on given blog post ideas. For instance, you can prompt ChatGPT to “Generate an outline for 

an article on [insert your article topic].”  

 

The more details you give in the prompt, the better the output will be. You can add more about the 

general direction of your article, the intended audience, and even some keywords you want to use. 

 

In the screenshot below, you can see how we’ve used this approach to ask ChatGPT to create an 

outline for a blog post on “How to use ChatGPT for content writing”. 

 

2. Write headlines and meta descriptions 
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You can use ChatGPT to provide suggestions for attention-grabbing headlines and informative meta 

descriptions based on a given topic or keyword. Let’s see this in action.  

 

Start by defining your main topic or keyword. Then, ask ChatGPT to generate a list of potential 

headlines for that keyword.  

 

For example, if you’re writing a blog post on the ‘benefits of Google Ads’, you can ask ChatGPT to 

“Write 5 headlines for a blog post on the benefits of Google Ads”. 

 

3. Summarize blog posts and URLs 

ChatGPT can be used to summarize text by utilizing its natural language processing capabilities. The 

model can read and analyze the text of a blog post, research paper, and even books to identify the 

main points and key takeaways. 

 

It can then use this information to generate a concise summary, highlighting the most important 

information and presenting it in a clear and digestible format.  

 

The free version of ChatGPT has a prompt character limit of up to 2048 characters, so you cannot 

copy and paste entire articles and ask the AI to analyze them. The new GPT-4 Turbo can handle 

around 300 pages of text in one prompt. 

 

One of the benefits of GPT-4 is its ability to access the internet through Bing search. So you can 

directly ask it to summarize a webpage 

 

4. Draft introductions and conclusions 

ChatGPT can assist you in drafting introductions and conclusions by providing you with suggestions 

based on the topic and purpose of your articles.  

 

You may start by asking ChatGPT to “Write an introduction/conclusion for a blog post on the 

benefits of Google Ads”. However, know that with this type of prompt ChatGPT is more likely to 

give you a generic output, you know, the dreaded “in the world of digital marketing” and how 

“Google Ads is growing at an exponential rate”. 

 

For better results, you should give ChatGPT more information regarding the information covered in 

your article, your article’s angle, purpose, intended audience, and writing tone.  

 

5. Aid keyword research 

ChatGPT is a language model trained to generate text based on prompts given to it, and it can be 

used to generate new ideas and suggestions for keywords and topics. Even though, it does not have 

the same level of precision and accuracy as dedicated keyword research tools. 

 

In addition, ChatGPT's output may not always be relevant or useful for your specific industry or 

niche. It may also generate some irrelevant or off-topic suggestions that could potentially harm your 

SEO efforts if you were to use them in your content. 
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With that in mind, here’s how to use ChatGPT to generate keyword ideas and identify content ideas. 

Once you’ve identified the topic you want to research, formulate a prompt that is specific to your 

topic. 

 

For example, you could ask ChatGPT "What are some related keywords for [topic]?" or "What are 

some long-tail variations of [keyword]?" 

 

6. Use writing prompts 

ChatGPT can use writing prompts to help you write better content by generating ideas and inspiring 

your creativity. The platform can generate writing prompts in different forms, such as questions, 

statements, or scenarios. 

 

These prompts can help you brainstorm new content ideas or generate transition words for your 

article. 

 

To use writing prompts with ChatGPT, you can start by providing a general topic or theme for your 

content. 

 

For example, if you are writing a blog post about “digital advertising”, you could ask ChatGPT to 

provide some writing prompts related to that topic. 

 

7. Compose ad copy 

As an AI-powered language model, ChatGPT has been trained on a vast corpus of text, including 

marketing and advertising copy.  

 

To use ChatGPT to compose ad copy, you can start by providing some basic information about your 

product or service, such as its features, benefits, target audience, and unique selling proposition 

(USP). 

 

You can also specify the type of ad you want to create, such as a social media ad, search engine ad, 

or display ad. 

 

Based on training data and on this information, ChatGPT can generate ad copy ideas, headlines, 

taglines, and even full ad scripts. 

 

8. Edit your content 

You can also ask ChatGPT to edit your content, e.g. to make it more concise, add examples, check 

for grammatical errors, and so on. 

 

 Ex: Prompt: "In a world where gravity suddenly stopped working, people started floating 

upwards. Write a story about how society adapted to this new reality."  
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TEST DATA: No Test data for this Experiment 

 ERROR: No Errors for this Experiment  

RESULT: A chatgpt output will be generated 
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Task 3 

Language Translation: Experiment with translation tasks by providing a sentence in one 

language and asking the model to translate it into another language. Compare the output to see 

how accurate and fluent the translations are.  

 Ex:Prompt: "Translate the following English sentence to French: 'Hello, how are you doing 

today?'"  

 

AIM: To Use Language Translation 

Theory: 

ChatGPT is a large language model (LLM) that was trained using natural language processing (NLP) 

on massive amounts of digital text in many languages. Its ability to translate between those 

languages is dependent on how much they were both included in its training data. 

 

Using ChatGPT for translation 

Using ChatGPT for translation is easy. To get started, create an account with OpenAI and log in to 

the ChatGPT interface. A good way to begin every new chat with ChatGPT is to give it a scenario. 

Tell it your background, what you hope to achieve from the interaction, and any persona you’d like it 

to take. 

 

In this case, you can begin by telling ChatGPT to act as a translator and translate your input language 

to your target language. 

Let’s start by signaling that we’re entering English text and want to translate it into French. 

 
Now that ChatGPT has its instructions, it’s time to ask it to translate the text. 

Let’s start by asking it to translate a simple sentence: can you walk the dog for me while I’m out of 

town? 

 
As you can see, we only needed to provide context at the beginning of the interaction. ChatGPT 

remembered the original context in the first message of the conversation and successfully translated 

the text to French. You can go through this process for any language, but the quality of the 

translation depends on ChatGPT’s training in those languages. Remember to provide clear 

instructions in your ChatGPT prompts to ensure the program responds correctly. Also, ChatGPT 

might lose context if the conversation gets too long. You may occasionally need to remind it of your 

instructions or start a new chat window. 
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Of course, you may not want to use ChatGPT in everyday work situations. OpenAI offers an 

application programming interface for these situations. 

 

An API allows you to call ChatGPT’s LLM from within your own applications. Doing this allows 

you to integrate translation features into a custom workflow or bulk-process translation text. 

How good is ChatGPT at translating text? 

It has been said that ChatGPT is highly accurate at translating text and its results are close to human 

translation. We ran some tests to see whether this is true and found that it fails to recognize slang 

words as well as cultural terms that are unique to a specific language, jeopardising the accuracy of 

translations. Let’s see what happened.  

 

First, we translated an informal sentence from Spanish to English with the slang word “primo”. The 

correct translation in English would use the words “brother” or “mate” in English; however, 

ChatGPT fails to recognize this slang word and provides the direct translation “cousin”, which does 

not really make sense in this context.  

 

When it comes to quality, the team at Ampere Translation observed that ChatGPT uses the passive 

voice excessively and sentences can be too long diluting the register and tone of the source language. 

As a language service provider that stands for quality, we would recommend using this tool to 

perhaps get a first draft and then relying on a professional translator to edit your content. 

 Ex:Prompt: "Translate the following English sentence to French: 'Hello, how are you doing 

today?'"  

 
TEST DATA: No Test data for this Experiment 

 ERROR: No Errors for this Experiment  
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RESULT: A chatgpt output will be generated 
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